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Preface

The Administration Application Reference Manual provides procedural and
reference information about Administration Tool, a suite of tools used to
perform system administration tasks in the Solaris™ 2.x environment. The
suite of tools is sometimes referred as admintool , the program that is used to
start the application tools.

Administration Tool was developed by Sun to provide a graphical user
interface for performing both simple and common administration tasks in the
Solaris 2.x environment in a consistent way.

This book also contains reference information about Software Manager. See the
Software and AnswerBook Packages Administration Guide for information on using
Software Manager.

Who Should Use This Book
This book is intended for experienced and junior administrators who need
information on using the administration tools to perform administrative tasks
such as setting up a user, printer, diskless client, or terminal.

Before You Read This Book
To use this book, you should be familiar with all aspects of Solaris 2.x system
administration. You should also be familiar with using a three-button mouse
and graphical user interface.
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How This Book Is Organized
This book is divided into two parts:

• Part 1—Using Administration Tool

Part 1 of this book provides task-specific information needed to use the
administration tools.

• Part 2—Administration Tool Reference

Part 2 of this book provides reference information about each tool’s
command menus and options.

This table provides a brief description of the chapters in this book.

Related Books
The following SunSoft documentation provides information on using the
OPEN LOOK version of the application tools, and can be used to provide
additional background information for the tools described in this book.

• Name Services Administration Guide
• Common Administration Tasks
• User Accounts, Printers, and Mail Administration
• SPARC: Installing Solaris Software
• x86: Installing Solaris Software
• Peripherals Administration

Chapter Numbers Contents

Part 1
Chapter 1 An overview of the administration tools and a description of

common features.

Chapter 2 Information about using the administration tools in a name
service environment and setting up administration tool
security.

Chapters 3-7 Information on performing specific system administration
tasks using the application tools.

Part 2
Chapters 8-14 Reference information about each tool’s commands, menus,

and windows.
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What Typographic Changes and Symbols Mean
The following table describes the type changes and symbols used in this book.

Table P-1 Typographic Conventions

Typeface or
Symbol Meaning Example

AaBbCc123 The names of commands, files,
and directories; on-screen
computer output

Edit your .login  file.
Use ls -a  to list all files.
system% You have mail.

AaBbCc123 What you type, contrasted with
on-screen computer output

system% su
Password:

AaBbCc123 Command-line placeholder:
replace with a real name or
value

To delete a file, type rm filename.

AaBbCc123 Book titles, new words or terms,
or words to be emphasized

Read Chapter 6 in User’s Guide.
These are called class options.
You must be root to do this.

Code samples are included in boxes and may display the following:

C shell prompt system%

Superuser prompt, C shell system#

Bourne and Korn shell prompt $

Superuser prompt, Bourne and
Korn shells

#
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Part 1 — Using Administration Tool

• Chapter 1, “Administration Tool Overview”

• Chapter 2, “Name Service Management”

• Chapter 3, “Managing User Accounts”

• Chapter 4, “Managing Printers”

• Chapter 5, “Managing Network Services”

• Chapter 6, “Using Serial Port Manager”
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Administration Tool Overview 1

Administration Tool is a graphical user interface used to perform
administrative tasks such as managing users, hosts, printers, and serial
devices.

This chapter contains the following topics.

When to Use Administration Tool page 2

Benefits of Administration Tool page 2

Requirements for Using Administration Tool page 3

Administration Tool Applications page 3

Starting Administration Tool page 4

Selecting a Name Service page 5

Filtering Entries page 6

Main Windows page 7

Typing in Text Boxes page 8

Buttons page 8

Using the Help Viewer page 9
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When to Use Administration Tool
Administration Tool applications enable you to manage:

• Important system database files such as aliases  and netmasks

• User account information including tasks such as adding users, modifying
password aging features, and removing user account information

• Local and remote printer setup

• Terminal and modem setup

• Diskless and dataless client setup

These tasks can be done on local and remote systems if the right access has
been set up. See Chapter 2, “Name Service Management,” for information on
controlling access to Administration Tool.

Benefits of Administration Tool
Using a graphical user interface to perform administration tasks has the
following benefits:

• The application programs are faster than using numerous SunOS™
commands to perform the same tasks.

• System files are updated automatically without the risk of making errors by
editing important system files manually.

• The application programs interact with appropriate system daemons and
notify you when the two are out of sync.
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Administration Tool Applications
Administration Tool provides the applications listed in Table 1-1.

Requirements for Using Administration Tool
You need the following to use Administration Tool:

• A bit-mapped display monitor – Administration Tool’s applications can be
used only on a system where the console is a bit-mapped screen such as a
standard display monitor that comes with a Sun system.

If you want to perform administration tasks on a system with an ASCII
terminal as the console, use SunOS commands.

• OpenWindows™ software.

• Superuser privilege or membership in the sysadmin group (group ID=14)
and the required access privileges for managing the NIS or NIS+ databases.
See Chapter 2, “Name Service Management,” for more information.

You should use Administration Tool as a regular user who has membership
in the sysadmin group rather than as superuser.

Table 1-1 Administration Tool Applications

Application Enables You to Manage ...

Database Manager Network-related system files such as aliases  and
netmasks

Host Manager Network client services

Printer Manager Local and remote printer setup

Serial Port Manager Serial devices

User Account Manager User account information
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Starting Administration Tool
Start Administration Tool from an OpenWindows window as follows:

You can also start Administration Tool with the -display  option to remotely
display Administration Tool on a bit-mapped screen.

The Administration Tool main window is displayed.

The Administration Tool main window is also referred to as the
Administration Tool launcher because it is used to start the applications.

The Administration Tool launcher menus are described in Table 1-2.

$ admintool &

Table 1-2 Administration Tool Launcher Menus

Menu Description

File Contains the Quit option used to exit and close the
Administration Tool launcher

Help Used to access Administration Tool’s Help Viewer

File Menu
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Selecting a Name Service
After you start the Administration Tool launcher and click on a tool icon, you
must select the name service appropriate for your environment.

Administration Tool can be used to manage information on the local system or
across the network by using the NIS+ name service. The sources of information
that can be managed by Administration Tool are described in Table 1-3.

Administration Tool can be used to manage three types of information: NIS+
tables, NIS maps, and /etc  files on the local system. This book refers to all
three types of information as system files.

See Chapter 2, “Name Service Management” for information on creating the
sysadmin group with or without using a name service.

Table 1-3 Available Name Services

 Name Service Select This Name Service to Manage ...

 NIS+ NIS+ table information. This requires sysadmin group (group
ID=14) membership and the appropriate ownership and
permission on the NIS+ tables that will be modified.

 NIS NIS map information can only be displayed using Administration
Tool; it cannot be modified.

 None The /etc  files on the local system. You must be superuser or a
member of the sysadmin group to modify these files. The local
system (identified under Host:) is selected by default.
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Filtering Entries
Each of the administration applications (except Printer Manager and Serial
Port Manager) provide a means of filtering entries if you do not want to see all
of the entries in a system file. You can specify a filter by clicking on the Show
menu. The following menu (from the Host Manager, for example) is displayed:

Table 1-4 describes the different Show commands.

After you have selected a name service and a method for filtering entries, click
on Apply. The tool’s main window is displayed.

Table 1-4 Show Commands

Option Use This Command To ...

All items Display all file entries. This is the default setting.

One item Specify a text string to display the file entries that match the text
string. Specifying wildcards is acceptable. This option is helpful if you
want to focus on a small number of entries.

No items Turn off file entry display. This is helpful if you only want to add new
entries and don’t want to view existing entries.
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Main Windows
Each application tool has a main (or base) window that looks similar to the
following Database Manager Main window.

The main window contains two areas: the control area and the pane.

The control area usually contains four menus: File, View, Edit, and Help.

Control Area

Pane
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Typing in Text Boxes
The following Add Entry window from Database Manager illustrates the text
boxes used for typing text in a tool window.

Buttons
The Add Entry window displayed above also illustrates some of the buttons
used in the application windows. Table 1-5 describes when to use each button.

Table 1-5 Administration Tool Buttons

Button Is Used To ...

OK Complete a task so that it can be processed. The window is
closed after the task is completed.

Apply Complete a task but leave the window open. (Not available on
all windows and not shown above.)

Reset Erase any text entered in the window and position the insertion
pointer in first field of the window.

Cancel Cancel the task and close the window.

Help Access the online Help Handbook.
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Using the Help Viewer

An important part of Administration Tool is an online Help handbook called
Help Viewer. Help Viewer provides detailed information about the
Administration Tool applications and their functions.

The Help Viewer handbook is accessed by clicking on a Help button. A Help
button can be found on the main Administration Tool window.

Help Viewer handbooks are also available for each of Administration Tool’s
five applications. These too are accessed by clicking on help buttons, found in
the main (base) window of each application.
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The online help handbooks are anywhere from ten to 65 pages long. Navigate
through the books by clicking on arrows in the upper-right corner that move
you from page to page, or by double-clicking on a subject in the handbook’s
Table of Contents to go directly to that topic.

See Table 1-6 for a summation of help’s navigational buttons.

Icons
You can close the Administration Tool launcher (and each tool) to an icon by
clicking on the file menu in the top left corner of each tool’s main window.

Proceed to Chapter 2, “Name Service Management,” for information on using
Administration Tool in your particular name service environment.

Table 1-6 Navigating Online Help

Button Name Use This Button To...

Help Access an Administration Tool’s Help Viewer

---->, <---- Go to the next page or previous page

Topic Go directly to a specific Help topic

Table of Contents Return to Help’s Table of Contents

Go Back Return to the Help page you were previously on

View Resize the Help window
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Name Service Management 2

Administration Tool can be used in different name service environments. An
important part of using Administration Tool is understanding how its security
features work in different environments and setting up security policies to
protect system files in your network of systems.

This chapters contains the following topics.

Name Service Environment
Administration Tool can be used to manage information on the local system or
across the network via a name service. The sources of information that can be
managed by Administration Tool are:

• Network Information Service (NIS) maps (display only)
• Network Information Service Plus (NIS+) tables
• /etc  files

See the section called “Using Administration Tool in a Name Service
Environment” on page 12 for information on using Administration Tool with
or without a name service environment.

Selecting a Name Service Environment page 12

Using Administration Tool in a Name Service Environment page 12

Additional Administration Tool Security Information page 15

Creating a Security Policy for Administration Tool page 19
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Selecting a Name Service Environment
After you start Administration Tool and click on an application icon, the Select
Name Service window is displayed. Choose the name service that is
appropriate for your environment from.

This example is from User Account Manager’s Load window.

Note – The NIS and NIS+ environments are not available for Serial Port
Manager and Printer Manager.

Using Administration Tool in a Name Service Environment
The following procedures describe how to use Administration Tool in each
name service environment.

In the NIS+ Environment

The requirements for viewing and modifying NIS+ table information are:

• Membership in the UNIX® group, sysadmin, which allows use of the
Administration Tool applications.
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• Modify permissions on the NIS+ tables to be managed. These permissions
are usually given to the NIS+ group members. See Name Services
Administration Guide for information on adding users to a NIS+ group.

▼ How to Add Authorized Users to the sysadmin Group

1. Log in as root on the NIS+ master server.

2. Type admintool &  in a shell or command tool window.
The Administration Tool main window is displayed.

3. Click on the Database Manager icon.
The Database Manager Load Database window is displayed.

4. Select the NIS+ naming service.

5. Select the Group file.

6. Click on Load.
The Group file is displayed.

7. Select Modify Entry from the Edit menu.
The Modify Entry window is displayed.

8. Add comma separated members (user names) to the sysadmin group
(group ID=14) entry.

9. Click on Modify.
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Without a Name Service

▼ How to Add Authorized Users to the sysadmin Group

This procedure assumes you will be using Administration Tool on the local
system only.

1. Become superuser on your system.

2. Edit the /etc/group  file.
Add an entry for the sysadmin group with a group ID of 14 and a comma
separated list of members (user names).

3. Log out and back in to activate this new group membership.

sysadmin::14: user_name, user_name, user_name
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Additional Administration Tool Security Information
Administration Tool uses the distributed system administration daemon
(admind ) to carry out security tasks when you perform administrative tasks
across the network. The admind  daemon executes the request on the server on
behalf of the client process and controls who can access Administration Tool.

Administering security involves authentication of the user ID (UID) and
authorization of permissions.

• Authentication means that the admind  daemon must authenticate the client
identity to the server. Before the admind  daemon can execute a request, it
must verify the identity of the client making the request.

• Authorization means that admind  verifies the authenticated user has
permission to execute Administration Tool on the server. After the client
identity is verified, admind  uses this identity to perform authorization
checks.

If you have permission to use Administration Tool, you also need to have
create, delete, or modify permission before you can change an NIS+ file. See
Name Services Administration Guide for a description of NIS+ security.

User and group identities are used for authorization checking as follows:

• Root identity – The root identity has superuser privileges (to access and
update data) only on the local system. If the server is the local system (in
other words, if the user has logged in as root on the server), the user will be
allowed to perform Administration Tool functions on the server under the
root identity.

• User ID – A regular user can view, but not change, information using
Administration Tool.

• User ID who is a member of sysadmin group (group ID=14) –
Administration Tool permissions are granted to users who are members of
the sysadmin group (group ID=14). This means that a user modifying
administration data must be a member of the sysadmin group on the system
where the task is being executed.
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Security Levels

Each request to change administration data contains a set of credentials with a
user ID (UID) and a set of group IDs (GIDs) to which the user belongs. The
server uses these credentials to perform identity and permission checks. Three
levels of authentication security are available.

The security levels are described in Table 2-1.

Note – Level 1 is the default security used by admind .

Table 2-1 Administration Tool Security Levels

Level Level Name Description

0 NONE No identity checking is done by the server. All user IDs are
set to the nobody  identity. This level is used mostly for
testing.

1 SYS The server accepts the original user and group identities from
the client system and uses them as the identities for the
authorization checks. There is no checking to be sure that the
user ID of the client represents the same user on the server
system. That is, it is assumed the administrator has made the
user IDs and group IDs consistent on all systems in the
network. Checks are made to see if the client has permission
to execute the request.

2 DES Credentials are validated using DES authentication, and
checks are made to be sure that the client has permission to
execute the request. The user and group identities are
obtained from files on the server system by mapping the
user’s DES network identity to a local user ID and set of
group IDs. The file used depends on which name service is
selected on the server system. Level 2 requires that a
publickey  entry exists for all server systems where the
admind  daemon is running, and for all users accessing the
tools. This levels provides the most secure environment for
performing administrative tasks.
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Changing the Security Level

You can change the security level from level 1 to level 2 by editing the
/etc/inetd.conf  file on each system, and adding the –S 2  option to the
admind  entry. If you do this, make sure that the servers on the domain are set
up to use security level 2.

You do not need to maintain the same level of security on all systems in the
network. You can run some systems, such as file servers requiring strict
security, at security level 2, while running other systems, such as workstations,
at the default level 1 security.

See the description of how to set up security for NIS+ in Name Services
Administration Guide.

Name Service Information

The admind  daemon uses information held by the name service. The three
sources of information are:

• Files in the /etc  directory such as passwd , group , and shadow, referred to
by the keyword files

• The NIS name service referred to by the keyword nis

• The NIS+ name service referred to by the keyword nisplus

On each system, the /etc/nsswitch.conf  file lists several administrative
files, followed by a list of one or more keywords that represent the name
services to be searched for information. If more than keyword is listed, they are
searched in the order given. For example, the entry

group: files nisplus

indicates that the security mechanism looks first in the local /etc/group  file
for an entry. If the entry exists, it uses the information in this entry. If it doesn’t
exist, the NIS+ group  file is searched.

By default, systems do not have an entry for the sysadmin group in the local
/etc/group  file. If you want to set up your system to use network-wide
information, do not add a sysadmin group to the local system. Remove it if it
exists.
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When running under Level 2 security, the security mechanisms use the
public/private key information. Make sure that the entry for publickey  is
followed by either nis  or nisplus  (depending on which name service you are
using), and remove the files  designation. See Name Services Administration
Guide for more information about the nsswitch.conf  file.
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Creating a Security Policy for Administration Tool
Consider the following when creating a security policy for using
Administration Tool in a name service environment.

• Determine how much trust is needed.

If your network is secure and you do not need to use authentication
security, you can use the Administration Tool applications with the default
level 1 security.

If you need to enforce a higher level of security, you can set the security
level of admind  to level 2. Level 2 security is primarily used with the NIS+
name service.

• Determine which name service will be used.

The name service determines where the security methods get information
about user and group identities. The name services are designated in the
/etc/nsswitch.conf  file (see “Name Service Information” on page 17).

• Decide which users have access to Administration Tool.

Decide which users will perform administrative functions over the network
with Administration Tool. List these users as members of the sysadmin
group accessed by the server system as defined in the
/etc/nsswitch.conf  configuration file.

• Determine global and local policies.

The global policy affects all hosts in the network. For example, you can create
a sysadmin group in the NIS or NIS+ group  file. Members of this group will
have permission to perform administrative tasks on all server systems that
list the network name service as the primary source of information. For
more information about the nsswitch.conf  file, see “Name Service
Information” on page 17.

A user can establish a local policy that is different from the global policy by
creating a sysadmin group in the local /etc/group  file and listing the
users who should have access to the local system. The members of this
group will have permission to use Administration Tool applications on the
user’s local system.

• Set up permissions for NIS+ management.
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You need the proper permissions when using Administration Tool to modify
or update the NIS+ files. In addition to the permissions required by
Administration Tool, the NIS+ security mechanisms impose their own set of
access permissions. The NIS+ security mechanisms are described in Name
Services Administration Guide.

• Set up access for NIS management.

In addition to the permissions required by Administration Tool, a user must
have a .rhosts  entry on the NIS master server to modify the NIS files.

• Set up initial security.

When a system is first installed, no UNIX group with a group ID of 14
exists. It must be created. You can use Administration Tool by logging in to
the server system as root.
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Managing User Accounts 3

This chapter describes Administration Tool’s User Account Manager
application, a graphical interface for managing user account information and
Database Manager, a graphical interface for managing system files.

Use this table to proceed directly to the section that provides step-by-step
instructions for the following tasks.

See Chapter 7, “User Account Manager Reference,” and Chapter 10, “Database
Manager Reference,” for additional information on each tool’s menus and
menu commands.

How to Start Database Manager page 23

How to Add a Group page 24

How to Start User Account Manager page 25

How to Add a User Account page 26

How to Modify a User Account page 29
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Overview of Adding a New User Account
This chapter describes the steps used to add a new user account including:

• Using Database Manager to add a group

• Using User Account Manager to add a user account, supplying the
following information:
• User name
• User ID
• Primary group ID
• Real name as a comment
• Login shell
• Password
• Home directory information

• Setting up the new user’s initialization files and home directory
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▼ How to Start Database Manager

The following procedure describes how to start Database Manager.

1. Type admintool &  from a shell tool prompt and press Return.
The Administration Tool main window is displayed.

2. From the Administration Tool main window, click on the Database
Manager icon.
The Load Database window is displayed.

3. Select the name service used in your network.

4. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.

5. Select the Group file.

6. Click on Load.
The group  file is displayed.
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▼ How to Add a Group

1. Choose Add Entry from the Edit Menu.
The Add Entry window is displayed.

2. Type the group name in the Group Name field.

3. Type the group ID in the Group ID field.

4. Click on Add.

5. Verify the group has been added by locating the entry in the main
window.
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▼ How to Start User Account Manager

The following procedure describes how to start User Account Manager.

1. Click on the User Account Manager icon from the Administration Tool
main window.
The Select Naming Service window is displayed.

2. Select the name service used in your network.

3. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.

4. Click on Apply.
The User Account Manager main window is displayed.
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▼ How to Add a User Account

This procedure describes how to add a user account. The procedure assumes
the group  file contains any groups referenced in the Add window.

1. Choose Add User from the Edit menu.
The Add User window is displayed.

2. Fill out the Add User window using the information described in
Table 7-4 on page 82 and the following instructions:

a. Specify the group name (users ) instead of the group ID (100 ) so that
you can quickly identify group ownership on the home directory.

b. Choose Normal Password from the Password menu to assign the new
user a password. Use this pop-up window to enter the password.

c. Use /etc/skel  as the skeleton path for the user’s home directory.
This prototype directory contains different initialization files for each
available shell type.

See an example of a completed Add User window on the next page.

3. Click on Add.

4. Verify the user has been added by locating the entry in the User Account
Manager main window.
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Completed Add Window
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▼ How to Set Up the New User’s Initialization File

Use this procedure to set up the user’s .login  file. The procedure assumes
that the /etc/skel  directory was used as the skeleton path for the user’s
home directory.

Log in to the new user’s system or into the system that contains the user’s
home directory.

1. Change to the user’s home directory.

2. Type mv local.login .login  and press Return.
This step renames the initialization file so it will be executed upon login.

3. Type rm local.*  and press Return.
This step deletes unused initialization files.

4. Add any additional files to the user’s home directory.

5. Test the new account by logging in as the new user.

# cd /export/home/ user_name
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▼ How to Modify a User Account

The following procedure describes how to modify a user account using User
Account Manager’s Modify command. Adding secondary group membership
is used as an example.

1. Select the user entry to modify from the User Account Manager main
window.

2. Choose Modify/View User from the Edit menu.
The Modify User window contains the selected user entry. The completed
form is displayed on the next page.

3. Add the appropriate secondary group membership.

4. Click on Apply.

Caution – User Account Manager’s Modify/View User command can only
change the user’s home directory entry in the passwd  database—not the home
directory on disk.

!
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Completed Modify Window
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▼ How to Delete a User Account

The following procedure describes how to use User Account Manager’s Delete
User command to remove a user account including the user’s home directory
and mailbox contents.

1. Select the user entry to remove from the User Account Manager main
window.

2. Choose Delete User from the Edit menu.
The Delete User window is displayed to confirm the removal of the user
account.

3. Click on the boxes for removing the user’s home directory and mailbox
contents, if desired.

4. Click on Delete when you are ready to remove the user account.
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▼ How to Search for User Account Information

Use User Account Manager’s Find command to search for a user account in a
large NIS/NIS+ passwd  file by user name, user ID, or comment.

1. Click on the Find button in the control area.

2. Fill in the Find User window with unique information about the user.

3. Click on Find.
The user entry, if found, will be highlighted in the main window.
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Managing Printers 4

This chapter describes how to manage printer information by using Printer
Manager.

Use this table to proceed directly to the section that provides step-by-step
instructions for the following tasks.

See Chapter 8, “Printer Manager Reference,” for additional information on
Printer Manager’s menus and commands.

Gathering Printer Information page 36

How to Start Printer Manager page 38

How to Install a Local Printer page 39

How to Add Access for a Remote Printer page 40

How to Modify a Printer Entry page 41

How to Delete a Printer Entry page 42
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Overview of Printer Manager
Printer Manager is a graphical user interface that simplifies the setup and
administration of local and remote printers across a network.

You can use Printer Manager from one system to add, modify, or delete printer
information on other systems. All systems to be administered in this way must
have Printer Manager software installed.

Definition of Terms
• A print server is a system that has a printer physically connected to it.
• A print client is a system that uses a print server for printing files.

Configuring Printer Services

Configuring printer services using Printer Manager involves three main tasks:

• Setting up the printer
• Physically connecting the printer to the system.
• Setting the printer switches and other settings.

• Setting up the print server
• Using Printer Manager to add a local printer to the print server.

• Setting up the print client
• Using Printer Manager to add access to a remote printer on the print

client. Printer Manager enables you to set up remote printer access for a
list of print clients in one session.

Printer Manager automatically configures the port monitor and service that is
used to pass remote print requests between the print client’s and print server’s
lpNet  daemons.

Note – Both print servers and print clients must have each other’s host name
and IP address in their local /etc/inet/hosts  file or in their name service’s
hosts  file.
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The Solaris 2.x Printing Environment
Print servers and their print clients can run different versions of the SunOS
operating system. For example, a configuration can include any combination of
client and server systems running the SunOS 4.1.x or 5.x operating systems.

Printer Manager, however, can run only on systems that have the SunOS 5.x
operating system installed. Therefore, you have some limitations on what you
can set up via Printer Manager, as summarized in Table 4.1:

Table 4-1

Server OS Client OS What You Can Do Through Printer Manager

4.1.x 4.1.x/4.x Cannot be set up through Printer Manager

5.x The 4.1.x server must previously have been set up
through lp  commands. The 5.x client can be set up
through Printer Manager.

5.x 4.1.x The 5.x print server can be set up through Printer
Manager; the 4.1.x client cannot.

5.x Both server and client can be set up through Printer
Manager.
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Gathering Printer Information

When Setting Up Print Servers...

Table 4-2 describes the buttons, menus, and text boxes on the window used to
install a local printer on a print server.

Table 4-2 Items on the Install Local Printer Window

Field Name Menu Type Description

Printer Name Field A unique name for the printer (maximum of 14 characters).

Comment Field A description of the printer.

Printer Port Menu The port the printer is connected to.

Printer Type Menu A designation for the type of printer. (See Chapter 8, “Printer
Manager Reference,” for a list of printer types.)

File Contents Menu The particular format of the file being printed without being
filtered, as long as the correct printer software is available. (See
Chapter 8, “Printer Manager Reference,” for a list of file content
types.)

Fault
Notification

Menu The method of notifying the superuser in case of a printer error.
Choices are: Write to superuser (in the console window), Mail to
superuser, or None.

System Default Button The default printer, the printer your print requests will be sent to if
you do not specify a printer.

Print Banner Button Used to control user permission to enable or disable banner page
printing.

Register with
NIS+

Button If the button is enabled, the printer name will be added to the NIS+
printer table.

User Access List Field The print clients that can print to this printer. By default, all print
clients have access to this printer. Use Add and Delete buttons to
add and remove print clients.
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Determining the File Content Types

It is important to associate the printer with the correct content type such PS for
PostScript printers and ASCII for ASCII printers. See User Accounts, Printers,
and Mail Administration and Chapter 8 for more information about determining
the file content types.

When Setting Up Print Clients...

Table 4-3 describes the buttons and fields in the window used to enable access
to a remote printer.

Before Using Printer Manager
Verify that the following requirements are met before using Printer Manager.

• A bit-mapped display monitor is connected to the system you are using.
• The OpenWindows environment is started using the following command:

• You have the required access privileges such as root (superuser) access to
the local system or membership in the sysadmin (group ID=14) group for
remote systems.

Table 4-3 Items on the Enable Access to Remote Printer Window

Field Name Menu Type Description

Printer Clients Field The print client name is identified here. (This is an inactive field.)

Printer Name Field The remote printer name.

Print Server Field The name of the system the remote printer is connected to.

Comment Field Description of the printer that helps you identify it.

Print Server OS Button Used to identify the BSD or SV protocol on the print server. BSD is
the default.

System Default Button Used to identify printer as the default printer, which is the printer
your print requests will be sent to if you do not specify a printer.

$ /usr/openwin/bin/openwin
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▼ How to Start Printer Manager

The following procedure describes how to start Printer Manager.

1. Type admintool &  from a command or shell tool prompt and press
Return.
The Administration Tool main window is displayed.

2. Click on the Printer Manager icon.
The Printer Manager main window is displayed.
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▼ How to Install a Local Printer

The following procedure describes how to install a local printer on a print
server.

1. Choose Add Local Printer from the Edit menu’s Add Printer option menu.
The Local Printer window is displayed.

2. Fill in the form by using the information described in the section called
“When Setting Up Print Servers...” on page 36.
An example of a completed form is displayed below.
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3. Click on Add.

4. Verify the local printer has been added by locating the new printer entry
in the Printer Manager main window.

▼ How to Add Access for a Remote Printer

The following procedure describes how to add access for a remote printer on a
print client.

1. Choose Add Access to Remote Printer from the Edit menu’s Add Printer
option.
The Access to Remote Printer window is displayed.

2. Fill in the form by using the information described in the section called
“Before Using Printer Manager” on page 37.
An example of a completed form is displayed below.

3. Click on Add.

4. Verify the printer access has been added by locating the new printer entry
in the Printer Manager main window.
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▼ How to Modify a Printer Entry

The following procedure describes how to modify a printer entry. Changing a
printer entry so that it will not accept or print any new print requests is used
as an example.

1. Choose Modify Printer from the Edit menu on the Printer Manager main
window.
The Modify Printer window is displayed.

2. Click on No on the Enable Print Queue option to disable the printer from
printing requests.

3. Click on No on the Accept Print Jobs option to prevent any further
queueing of print requests.
An example is displayed below.

4. Click on Apply.
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▼ How to Delete a Printer Entry

The following procedure describes how to remove a printer entry.

1. Remove all currently queued print requests to this printer with the
cancel  or lpmove  commands.

2. Choose the Delete Printer command from the Edit menu on the Printer
Manager main window.
A window is displayed asking you to confirm the deletion.

3. Click on Delete when you are ready to remove the printer entry.



43

Managing Network Services 5

This chapter describes how to manage network services by using two
Administration Tool applications:

• Host Manager, a graphical interface for managing network client
information

• Database Manager, a graphical interface used to manage network-related
system files

Use this table to proceed directly to the section that provides step-by-step
instructions for the following tasks.

See Chapter 9, “Host Manager Reference,” and Chapter 10, “Database Manager
Reference,” for additional information on each tool’s menus and commands.

How to Start Host Manager page 46

How to Add Standalone System Information page 47

How to Add Support for a Diskless Client page 49

How to Add Support for a Dataless Client page 52

How to Display Host Information page 54

How to Enable Remote Software Installation Privileges page 55

How to Start Database Manager page 57

How to Add a System File Entry page 59

How to Modify a System File Entry page 59

How to Delete a System File Entry page 59
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Overview of Host Manager
The first part of this chapter describes how to use Host Manager to manage
network client information. A network client is a system that uses remote
resources from a server. Network client systems include standalone, diskless,
and dataless system configurations.

Host Manager is primarily used on a local server system to manage support for
diskless and dataless clients that need remote file resources and disk storage
space. In addition, Host Manager can be used on remote systems with the
appropriate access privileges.

There are also important reasons for using Host Manager to add information
about standalone systems.

• Host names and IP addresses must be registered in the hosts  file on
systems that want to use network access commands such as rlogin  and
rcp .

• Standalone systems without CD-ROM drives can be authorized for remote
installation privileges via Host Manager’s remote installation setup menu.

Note – Host Manager cannot be used to modify host information. You must
remove the host information and then re-add it.

This second part of this chapter describes Database Manager, another tool for
managing network-related system files.
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Before Using Host Manager
Verify that the following requirements are met before using Host Manager:

• A bit-mapped display monitor is connected to the system you are using.

• The OpenWindows environment is started using the following command:

• You have the required access privileges such as root (superuser) access to
the local system or membership in the sysadmin (group ID=14) group for
remote systems. If you are using Host Manager to update a NIS or NIS+ file,
you must be a member of the sysadmin group and have the appropriate
access privileges.

Refer to Chapter 2, “Name Service Management,” for information on setting
up the name service security features.

$ /usr/openwin/bin/openwin
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▼ How to Start Host Manager

The following procedure describes how to start Host Manager.

1. Type admintool &  from a command or shell tool prompt and press
Return.
The Administration Tool main window is displayed.

2. Click on the Host Manager icon.
The Select Naming Service window is displayed.

3. Select the name service used in your network.

4. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.

5. Click on Apply.
The Host Manager main window is displayed.
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▼ How to Add Standalone System Information

Use these steps to add standalone system information. The following items
must be provided for the standalone system:

• Host name
• IP address
• Ethernet address

1. Choose Add Host from the Edit menu on the Host Manager window.
The Add Host window is displayed.

2. Fill out the Add window by using the information described in Table 9-4
on page 112. See an example of a completed Add Host window on the
following page.

3. If this system will be installed remotely, follow steps a and b to enable
remote install privileges. Otherwise, skip to step 4.

a. Click on the Enable button under Remote Install.
The Media Server defaults to the current host.

b. Select Other from the Media Server pull-down menu to specify
another host as the media server, if necessary. Type the host name in
the text box provided and click on Apply in the Specify Media Server
window.

4. Click on Add in the Add Host window.

5. Verify that the new host has been added by locating the new host entry in
the Host Manager main window.
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Completed Add Window
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▼ How to Add Support for a Diskless Client

Use these steps to add support for a diskless client. This procedure assumes
the system providing the services has already been configured as a server,
meaning the /export  and /export/swap  file systems are already created.
The following items must be provided for the diskless client:
• Host name
• IP address
• Ethernet address

Default settings are also available for:
• Time zone region and time zone
• File server
• OS release
• Root and swap paths
• Swap size

1. Choose Add Host from the Edit menu on the Host Manager main window.
The Add Host window is displayed.

2. Choose diskless from the Client Type menu.

3. Fill out the Add Host window by using the information described in
Table 9-4 on page 112. See an example of a completed Add window on
page 51.

4. If another host will act as the file server for this system, follow steps a and
b. Otherwise, skip to step 5.

a. Select Other from the File Server menu to specify another host as the
file server.

b. Fill out the host information in the Specify File Server window
provided and click on Apply.

5. Click on Add in the Add Host window.
It takes several minutes to add the diskless client support, particularly to
create the client’s root and swap areas.

6. You may need to reboot the file server to start the appropriate client
daemons after the client information has been added successfully.
A message about rebooting the system will be displayed.
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7. Boot the diskless client system.

8. Provide the following system configuration information for the diskless
client during the initial boot process, if prompted.
• Geographic region
• Time zone
• Date and time

9. Create a root password when prompted.

# boot net
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Completed Add Window
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▼ How to Add Support for a Dataless Client

The following procedure describes how to add support for a dataless client on
a server. This procedure assumes the following tasks have already been
completed:

• The system providing the services has already been configured as a server,
meaning the /export  file system is already created.

• The dataless client system has already been configured using the Solaris
installation program. See SPARC: Installing Solaris Software” or x86: Installing
Solaris Software” for information about using the Solaris installation
program.

1. Choose Add Host from the Edit menu on the Host Manager main window.
The Add Host window is displayed.

2. Choose dataless from the Client Type menu.

3. Fill out the Add Host window by using the information described in
Table 9-4 on page 112. See an example of a completed Add Host window
on page 53.

The following information must be provided for the dataless client:
• Host name
• IP address
• Ethernet address

Default settings are also available for:
• Time zone region and time zone
• File server
• OS release
• Remote install
• Media server

4. Click on Add.
It takes several minutes for the dataless client support to be added.
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Completed Add Window
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▼ How to Display Host Information

There are two ways to view host information:

• Double clicking on a host entry in the Host Manager main window

• Choosing the View Host command from the Edit menu

Either way, the following information is displayed:

Note – The View Host window will not include a system’s Ethernet address if
the host entry was added to the /etc/inet/hosts  file manually, and there
was no corresponding entry added to the /etc/ethers  file.
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Additional Network Client Tasks
The following section describes additional network client tasks that are
performed occasionally.

▼ How to Enable Remote Software Installation Privileges

This procedure describes how to enable remote software installation privileges
for an existing system. This feature allows you to use the boot net  command
from the client system to perform a remote installation.

This procedure assumes the media server is accessible over the network and
the installation CD is in the CD-ROM drive.

1. Select a host entry in the Host Manager main window.

2. Choose Enable Remote Install from the Edit menu.
The Remote Install window is displayed.

3. Verify the Media Server name and if necessary, select Other from the
Media Server menu to specify an alternate media server.

i. If Host Manager does not understand how the CD is mounted on
the media server, you will be prompted to supply a path name for
the CD. The path name may be one of the following:
/cdrom/cdrom0/s0
/cdrom/cdrom0/s2

ii. On x86 systems, you may have to select the media server system
again to specify the CD pathname.
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4. Verify that the OS Release for the system is correct and if necessary, select
an alternate OS Release from the OS Release menu.

5. Click on Apply.

▼ How to Delete Host Information

The following procedure describes how to delete host information.

1. Select the host to be deleted from the Host Manager main window.

2. Choose Delete Host from the Edit menu.
A window is displayed asking you to confirm the deletion.

3. Click on Delete when you are ready to delete the host information.
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Managing Network Services Files
The following section describes how to use Database Manager to manage
network services files.

▼ How to Start Database Manager

The following procedure describes how to start Database Manager.

1. Type admintool &  from a command or shell tool prompt and press
Return.
The Administration Tool window is displayed.

2. Click on the Database Manager icon.
The Load Database window is displayed.

3. Select the name service used in your network.

4. Check that the domain or host name is correct.
If not, type the domain or host name you need to access.
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5. Select the file you want to display.
The aliases  file, for example.

6. Click on Load.
The Database Manager main window is displayed with the aliases  file
contents displayed.
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▼ How to Add a System File Entry

The following procedure describes how to add an entry to a system file.

1. Select Add Entry from the Edit menu on the Database Manager main
window.
The Add Entry window displays.

2. Fill out the Add Entry window by using Table 10-5 on page 125 to
determine the information required when adding an entry to the specified
system file.

3. Click on Add.

▼ How to Modify a System File Entry

The following procedure describes how to modify a system file entry.

Caution – Notify users before you modify their work environment.

1. Select a system file to modify from the Database Manager main window.

2. Choose Modify Entry from the Edit menu.
The Modify Entry window is displayed.

3. Fill out the Modify window by using Table 10-5 on page 125 to determine
the modifiable fields for the specified system file.

4. Click on Modify when finished.

▼ How to Delete a System File Entry

The following procedure describes how to delete a system file entry.

1. Select a system file to remove an entry from in the Database Manager
main window.

2. Select Delete Entry from the Edit menu.
A window is displayed asking you to confirm the deletion.

3. Click on Delete if you really want to delete the system file entry.

!
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Advanced Uses for Database Manager

Database Manager is primarily used to manage the network-related system
files since other tools are used to manage user, client system, serial ports, and
printer-related files.

Using Database Manager to add an entry to a system file usually managed by
another tool can save time. For example, Host Manager requires the Ethernet
address when adding a standalone system even though you may want to use
this system for remote copy and login only. (However, the Ethernet address is
not required when you use Database Manager to update the hosts  file.)

Caution – Do not bypass critical information when providing services to users
and client systems. Use caution when using Database Manager to update
system files normally managed by other tools.

1. Select the hosts  file from the Load Database window, and click Load.
The hosts  file is displayed in Database Manager’s main window.

2. Select Add Entry from the Edit menu.
The Add Entry window is displayed.

3. Fill in the host information.

4. Click on Add.

!
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Using Serial Port Manager 6

Modems and terminals provide both local and remote access to system and
network resources. Maintaining this access with Serial Port Manager, an
Administration Tool application, is an important, if infrequent, responsibility
of a system administrator.

Use this table to proceed directly to the section that provides step-by-step
instructions for the following tasks.

See Chapter 11, “Serial Port Manager Reference,” for additional information on
Serial Port Manager’s menus and commands.

How to Start Serial Port Manager page 63

How to Add a Terminal page 64

How to Add a Modem page 66

Initializing a Port Without Configuring page 69

How to Disable a Port page 71

How to Delete a Port Service page 72
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Overview
Serial Port Manager is an Administration Tool application used for adding and
maintaining port services for terminals and modems.

The Serial Port Manager configures the serial port software to work with
terminals and modems by calling the pmadm command and supplying the
appropriate information. It features:

• Templates for common terminal and modem configurations
• Multiple port setup, modification, or deletion
• Quick visual status of each port

Before Using Serial Port Manager
Verify that the following requirements are met before using Serial Port
Manager:

• A bit-mapped display monitor is connected to the system you are using.

• The OpenWindows environment is started using the following command:

• You have the required access privileges such as root (superuser) access to
the local system or membership in the sysadmin (group ID=14) group for
remote systems.

Refer to Chapter 2, “Name Service Management,” for information on setting
up the name service security features.

$ /usr/openwin/bin/openwin
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▼ How to Start Serial Port Manager

The following procedure describes how to start Serial Port Manager.

1. Type admintool &  from a command or shell tool prompt and press
Return.

2. Click on the Serial Port Manager icon.
The Serial Port Manager main window is displayed.
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▼ How to Add a Terminal

Follow these steps to add a terminal to a system.

1. From the Serial Port Manager main window, select the port or ports that
will be used with a terminal

2. Choose Modify Service from the Edit menu.
The Modify Service window is displayed in the Basic Detail mode. (Click on
More or Expert to select either the More or Expert Detail modes.)

3. Choose Terminal – Hardwired from the Template menu.
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Table 6-1 shows the values that the Terminal – Hardwired template provides
for the selected port. See Chapter 11, “Serial Port Manager Reference,” for more
information about these items.

4. Change values of template entries if desired.

5. Click on Apply to configure the port.

Table 6-1 Terminal – Hardwired Default Values

Detail Item Default Value

Basic Port —

Service Enabled

Baud Rate 9600

Terminal Type tvi925

More Option: Initialize Only no

Option: Bidirectional no

Option: Software Carrier yes

Login Prompt login:

Comment Terminal – Hardwired

Service Tag —

Port Monitor Tag zsmon

Expert Create utmp  entry yes

Connect on Carrier no

Service /usr/bin/login

Streams Modules ldterm,ttcompat

Timeout (secs) Never
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▼ How to Add a Modem

Follow these steps to add a modem to a system.

1. From the Serial Port Manager main window, select the port or ports that
will be used with a modem.

2. Choose Modify Service from the Edit menu.
The Modify Service window appears in the Basic Detail mode. (For
additional details, select either the More or Expert Detail modes.)

3. Choose the modem configuration from the Template menu that meets or
most closely matches your modem service.
The modem template choices are described in Table 6-2.

See Table 6-3 on page 68 for the default values of each modem template. If a
UUCP service will be used to dial in to your modem on a Solaris 2.x system,
see “How to Configure a Modem for Use With UUCP” for the rest of the
procedure.

4. Change values of template entries if desired.

5. Click on Apply to configure the port.

Table 6-2 Modem Templates

Modem Configuration Description

Modem – Dial In Only Users may dial in to the modem but cannot dial out.

Modem – Dial Out Only Users may dial out from the modem but cannot dial in.

Modem – Bidirectional Users may either dial in or out from the modem.
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▼ How to Configure a Modem for Use With UUCP

UUCP sends information using seven bits and even parity. Solaris 2.x modem
configurations use eight bits and no parity to meet international compatibility
requirements. To set up your modem service to work with UUCP, follow these
instructions.

1. Follow Step 1 through Step 3 in the “How to Add a Modem” procedure.

2. On the Modify Service window, choose Other from the Baud Rate menu.

3. Enter a baud rate value from the /etc/ttydefs  file that provides seven
bit, even parity service and click on Apply.

In this example, the 9600E baud rate was selected. This provides a service
with a 9600 baud rate, seven bits, and even parity.

4. Change values of other template entries if desired.

5. Click on Apply to configure the port.
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Modem Template Default Values

The modem templates provides the following values for the selected port. For
more information, see Chapter 11, “Serial Port Manager Reference.”

Table 6-3 Modem Template Default Values

Detail Item Modem – Dial In Only Modem – Dial Out Only Modem – Bidirectional

Basic Port — — —

Service Enabled Enabled Enabled

Baud Rate 9600 9600 9600

Terminal Type — — —

More Option: Initialize Only yes no no

Option: Bidirectional no no yes

Option: Software
Carrier

no no no

Login Prompt login: login: login:

Comment Modem – Dial-In Only Modem – Dial-Out Only Modem – Bidirectional

Service Tag — — —

Port Monitor Tag zsmon zsmon zsmon

Expert Create utmp  Entry yes yes yes

Connect on Carrier no no no

Service /usr/bin/login /usr/bin/login /usr/sbin/login

Streams Modules ldterm,ttcompat ldterm,ttcompat ldterm,ttcompat

Timeout (secs) Never Never Never
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▼ Initializing a Port Without Configuring

Follow these steps to initialize a port without configuring a specific device. Use
Table 6-4 on page 70 for default values of the Basic, More, or Expert Detail
modes.

1. Select the port or ports that you want to initialize from the Serial Port
Manager main window.

2. Choose Modify Service from the Edit menu.
The Modify Service window appears in the Basic Detail mode. For
additional details, select either the More or Expert Detail modes.

3. Choose Initialize Only – No Connection from the Template menu.

4. Click on Apply to initialize the port.
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The Initialize Only – No Connection template provides the following values for
the selected port. For more information, see Chapter 11, “Serial Port Manager
Reference.”

Table 6-4 Initialize Only – No Connection Default Values

Detail Item Default Value

Basic Port —

Service Enabled

Baud Rate 9600

Terminal Type —

More Option: Initialize Only yes

Option: Bidirectional no

Option: Software Carrier no

Login Prompt login:

Comment Initialize Only – No Connection

Service Tag —

Port Monitor Tag zsmon

Expert Create utmp  Entry yes

Connect on Carrier no

Service /usr/bin/login

Streams Modules ldterm,ttcompat

Timeout (secs) Never
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▼ How to Disable a Port

Follow these steps to disable a service on a configured port.

1. Select the port or ports that you want to disable from the Serial Port
Manager main window.

2. Choose Modify Service from the Edit menu.

3. Click Service Disabled in the Modify Service window to disable the port.
The other items in the Modify Service window will turn gray when the port
service is disabled.

4. Click on Apply to disable the port.
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▼ How to Delete a Port Service

Follow these steps to delete a service on a configured port.

1. Select the port or ports with a service you want to delete from the Serial
Port Manager main window.

2. Choose Delete Service from the Edit menu.

A window is displayed asking you to confirm that the service should be
removed.

3. Click on Delete when you are ready to remove the service.
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• Chapter 7, “User Account Manager Reference”

• Chapter 8, “Printer Manager Reference”

• Chapter 9, “Host Manager Reference”

• Chapter 10, “Database Manager Reference”

• Chapter 11, “Serial Port Manager Reference”

• Chapter 12, “Software Manager Reference”
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User Account Manager Reference 7

This chapter provides reference information for User Account Manager.

Use this table to find information about specific User Account Manager
features.

Using User Account Manager page 76

User Account Manager Select Naming Service Window page 78

User Account Manager Main Window page 79

Add User Window page 81

Modify/View User Window page 85

Copy User Window page 87

Delete User Window page 89

Files Modified by User Account Manager page 90
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Using User Account Manager

When to Use User Account Manager

User Account Manager can be used to perform the following tasks:

• Add, display, and remove user account information

• Copy user account information to facilitate the creation of user accounts
with similar characteristics

• Modify user account information such as adding password aging features

Requirements for Using User Account Manager

The requirements for using User Account Manager are:

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using User Account Manager

User Account Manager cannot be used on an ASCII terminal. All user account
related tasks can be performed using SunOS commands. Table 7-1 provides
more information about choosing to use User Account Manager or SunOS
commands.

Table 7-1 When to Use User Account Manager

Use User Account Manager If You: Use SunOS Commands If You:

Have a bit-mapped display monitor Are using an ASCII terminal

Are running OpenWindows Want output for each command issued
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Where to Find Specific Task Information

This table contains references for User Account Manager tasks.

Table 7-2 Where to Find User Account Task Information

Task Location

How to Start User Account Manager page 25

How to Add a User Account page 26

How to Modify a User Account page 29

How to Search for User Account Information page 32
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Window, Menu, and Command Descriptions

User Account Manager Select Naming Service Window

When you start User Account Manager or click on the Naming Service button,
the following window is displayed:

This window is used to select:

• The appropriate name service for your environment. See Chapter 2, “Name
Service Management” for information on selecting a name service.

• The amount of user information to be displayed in the User Account
Manager main window. This is done using the Show menu, which is
described in Chapter 1, “Administration Tool Overview.”

After you have selected a name service and a method for filtering the user
entries that are displayed, click on Apply. The user account information is
loaded and the User Account Manager main window is displayed.
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User Account Manager Main Window

The User Account Manager main window is displayed after you click on the
User Account Manager icon on the Administration Tool window.

The main window contains the Edit, Find, Naming Service, and Help menus.
The passwd  file contents are also displayed.
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Edit Menu Commands

The Edit menu commands are described in Table 7-3.

Find Command

The Find menu command is used to find and highlight a specific user account
entry.

Naming Service Command

The Naming Service menu command is used to return to the Naming Service
window where you can select an alternate name service.

Help Menu Command

Use the Help menu command to access an online handbook that describes how
to use the User Account Manager application. See “Using the Help Viewer” on
page 9 for more information.

Table 7-3 User Account Manager Edit Menu Commands

Command Use This Command To ...

Add User Add a user account

Modify/View
User

Modify or view selected user account information

Copy User Create a new account by copying selected information from an
existing account

Delete User Remove a user account

Refresh List Rebuild user account display after manually editing the passwd
file.
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User Account Manager Edit Menu

Add User Window

The Add User window is used to add a user account. You are prompted to
supply the information described in Table 7-4.

Note – The password aging features in the Account Security section on the
Add User window will not appear if you are adding the user to the NIS
password database.
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Table 7-4 Items on the User Account Manager Add Window  (1 of 3)

Category Item Name
Menu
Type Description

User Identity User Name Field Unique name by which the user is
known to the system. Valid
characters are alphanumerics plus
the underscore (_); no other
characters are acceptable. First
character must be a letter; name
must include at least one
lowercase letter.

User ID Field Unique number in the range
100–60,000 that identifies the user
to the system.

Primary Group Field A group identifier associated with
a particular group. Range is
100–60,000. Default is 100.

Secondary
Groups

Field One or more group names or
numbers to which the user also
belongs. If you enter more than
one name or number, separate
them with commas. Default is
none.

Comment Field Information such as user’s full
name, phone number, and
organization.

Login Shell Menu Name of program that starts at
login: /bin/sh  for the Bourne
shell, /bin/csh  for the C shell, or
/bin/ksh  for the Korn shell.
Default is the Bourne shell.
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Account
Security

Password Menu Password status setting. Default is
no password until first login.

Min Change Field Minimum number of days
between password changes. Used
to prevent a user from changing a
password and immediately
changing it back to the original
password. Default is no minimum.

Max Change Field Number of days the password
may remain unchanged. If the
password has not been changed
within this number of days, the
user will not be able to log in to
the account. The administrator
must reactivate the account.
Default is no expiration.

Max Inactive Field Number of days an account can go
unused (no login) before it is
automatically locked. Default is no
limit.

Expiration Date Menus Date on which the user account
expires. Default is no expiration
date.

Warning Field The number of days before a
password expires that the user is
warned. Default is no warning.

Table 7-4 Items on the User Account Manager Add Window  (2 of 3)

Category Item Name
Menu
Type Description
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Home
Directory

Create Home
Dir

Check Box Setting to create a home directory
for the new user account.

Path Field The full path to the home directory
for this user account. By
convention, this is
/export/home/ user-name.

Server Field The host name (the name you
assigned to your system when you
installed the system).

Skeleton Path Field The path name (usually
/etc/skel ) that contains the
initialization files to be supplied
for this user. Example: .login

AutoHome
Setup

Check Box Setting to create an automount
entry for user’s home directory.

Permissions
   Owner:
   Group:
   World:

Check Box Permissions to read, write, and
execute files by owner, group, and
world in the home directory.

Miscellaneous Mail Server Field Name of the system where the
user’s mailbox is located.

Cred. Table
Setup

Check Box NIS+ security entry for the user.

Table 7-4 Items on the User Account Manager Add Window  (3 of 3)

Category Item Name
Menu
Type Description
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Modify/View User Window

The Modify/View User window is used to modify selected user account
information such as the account security features.
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The Modify User window can be used to change the user ID and home
directory path. It cannot be used to change the user ID. Instead, use the Delete
User command on the Edit menu to delete the user account and re-add the
account using the Add command specifying a new user ID.
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Copy User Window
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Use the Copy User command to create a user account by copying selected
information from an existing user account and modifying that information as
needed. This feature is useful when you need to create several similar user
accounts.

The user name, user ID, and password are not copied because they should be
unique.
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Delete User Window

Use the Delete User command to remove an existing user account.

Clicking on the Delete home directory and Delete mailbox buttons removes the
user’s home directory and mailbox contents. User Account Manager does not
remove files belonging to the user that are stored in other locations.

User Account Manager Find Command

The Find command enables you to search through the passwd  file to find a
user account entry.

You can search by user name, user ID, or comment, but not by combinations of
the items. You can also use wildcards to match text strings.
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Files Modified by User Account Manager
Table 7-5 describes the system files that are modified by User Account
Manager.

Table 7-5 Files Modified by User Account Manager

System File Description

auto_home An indirect automounter map that contains entries enabling
client systems to mount their home directories automatically

group A file containing UNIX group entries recognized on the local
system or in a name service

passwd A file containing user account entries such as user name, user
ID, group ID, and home directory

shadow A file containing user password entries in encrypted form, and
password aging information
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Printer Manager Reference 8

This chapter provides reference information for Printer Manager.

Use this table to find information about specific Printer Manager features.

Using Printer Manager page 92

Printer Manager Main Window page 94

Add Access to Remote Printer Window page 96

Add Local Printer Window page 97

Modify Printer Window page 100

Delete Printer Window page 101

Find Printer Command page 103

Files Modified by Printer Manager page 104
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Using Printer Manager

When to Use Printer Manager

Printer Manager can be used to:

• Add, display, and remove printer information
• Access remote printers on behalf of print clients over the network
• Access remote print servers over the network

Requirements for Using Printer Manager

The requirements for using Printer Manager are

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using Printer Manager

Printer Manager cannot be used on an ASCII terminal. If needed, all printer
tasks can be performed using SunOS commands. Table 8-1 provides more
information about choosing to use Printer Manager or SunOS commands.

Table 8-1 When to Use Printer Manager

Use Printer Manager If You: Use SunOS Commands If You:

Have a bit-mapped display monitor Are using an ASCII terminal

Are running OpenWindows Want output for each command issued
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Where to Find Specific Task Information

This table contains references for Printer Manager tasks.

Table 8-2 Where to Find Printer Manager Task Information

Task Location

How to Start Printer Manager page 38

How to Install a Local Printer page 39

How to Add Access for a Remote Printer page 40

How to Modify a Printer Entry page 41

How to Delete a Printer Entry page 42
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Window, Menu, and Command Descriptions

Printer Manager Main Window

The Printer Manager main window is displayed after you click on the Printer
Manager icon on the Administration Tool window.

The main window contains the View, Edit, Goto and Help menus. The main
window also displays the printers that have been added to the system, if any.

View Menu Commands

The View menu commands are described in Table 8-3.

Table 8-3 Printer Manager View Menu Commands

Command Use This Command To ...

Show NIS+ Printers This command is not available at this time

Find Find and highlight a specific printer entry
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Edit Menu Commands

The Edit menu commands are described in Table 8-4.

Goto Menu Command

The Goto menu command enables you to display printer information on
another host. If you have the appropriate access privileges, you can also use
this feature to modify printer information on another host.

Help Menu Commands

Use the Help menu command to access the Help Viewer online handbook that
describes Printer Manager functions and requirements. See “Using the Help
Viewer” on page 9 for more information.

Table 8-4 Printer Manager Edit Menu Commands

Command Use This Command To ...

Add Access to Remote
Printer

Add access to a remote printer for the designated system

Add Local Printer Add a local printer to the system

Modify Printer Modify printer characteristics, such as availability and
control of print requests

Delete Printer Delete a printer entry
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Printer Manager Edit Menu

Add Access to Remote Printer Window

Use this window to add access to a remote printer. Supply the following
information:

• Printer name
• Printer server
• Print server OS
• Whether this printer is the default system printer
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Add Local Printer Window

Use this window to add access to a local printer, and to specify information
such as printer type, fault notification, and user accessibility.

Each check box, field, and menu in the window is described on the following
pages.
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Printer Port Menu
Select the appropriate printer port from this menu.

Printer Type Menu
Select the appropriate printer type from this menu, which lists various printers
derived from their manufacturers’ name or model number. The default printer
type is PostScript.

For special cases, select Other to specify another printer type. See User
Accounts, Printers, and Mail Administration for instructions on adding other
printer types.

Printer Port Description

/dev/term/a Device name of port to which printer is attached. This is the
default setting.

/dev/term/b Device name of port to which printer is attached.

Other Select Other to specify another port.

PostScript

HP Printer

Reverse PostScript

Epson 2500

IBM ProPrinter

Qume Sprint 5

Daisy

Diablo

Datagraphix

DEC LA100

DEC LN03

DECwriter

Texas Instruments 800

Other
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File Contents Menu
Use this menu to select the type of file that can be printed. The default file
content type is Any.

Fault Notification Menu
Use this menu to choose the action to take in case of a printer error.

PostScript

ASCII

Both PostScript and ASCII

None

Any

Method of Fault
Notification Description

Write to superuser Superuser is notified in the console window. This is the
default setting.

Mail to superuser Superuser is notified via electronic mail.

None No action occurs.
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Modify Printer Window

The Modify Printer window enables you to change categories of information,
depending on whether the printer is local or remote. The most common
reasons for using the Modify window are:

• Disabling or enabling printing of print requests

• Enabling or preventing queueing of print requests

• Changing system default printer



Printer Manager Reference 101

8

Delete Printer Window

Use the Delete Printer command to remove a printer entry. All currently
queued print requests to this printer must be removed with the cancel  or
lpmove  commands before the printer entry can be successfully removed.

The following window is displayed asking you to confirm the deletion:
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Printer Manager View Menu

Show NIS+ Printers Command

The Show NIS+ Printers command enables you to display printer names
defined in the NIS+ printer database.
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Find Printer Command

The Find Printer command enables you to search through the printer entries
for a particular entry. This command is useful when you are working with a
large number of entries.
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Files Modified by Printer Manager
Table 8-5 describes the system files that are modified by Printer Manager.

Table 8-5 Files Modified by Printer Manager

System File Description

/etc/lp/default A file containing the name of the default printer

/etc/lp/printers A directory containing configuration information about
each printer

/etc/lp/Systems A file containing the remote hosts registered with print
service

/etc/lp/filter.table A printer filter lookup table of downloaded filter
information

/etc/lp/interfaces/
printer_name

A file containing the default interface program used to
set default printer settings
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This chapter provides reference information for Host Manager.

Use this table to find information about specific Host Manager features.

Using Host Manager page 106

Window, Menu, and Command Descriptions page 108

Host Manager Naming Service Window page 108

Host Manager Main Window page 109

Host Manager Edit Menu page 111

Add Host Window page 111

View Host Window page 114

Remote Install Window page 115

Host Manager Find Command page 117

Files Modified by Host Manager page 118
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Using Host Manager

When to Use Host Manager

Host Manager can be used to perform the following tasks:

• Add, display, and remove network client support (which includes
standalone, diskless, and dataless system configurations)

• Enable and disable remote software installation privileges

Requirements for Using Host Manager

The requirements for using Host Manager are:

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using Host Manager

Host Manager cannot be used on an ASCII terminal. Instead, you can use
SunOS commands or ttyhstmgr , an ASCII menu interface, for host
management tasks. Table 9-1 provides more information about choosing to use
Host Manager or SunOS commands.

Table 9-1 Using Host Manager

Use Host Manager If You: Use SunOS Commands If You:

Have a bit-mapped display monitor Are using an ASCII terminal

Are running OpenWindows Want output for each command issued
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Where to Find Specific Task Information

Table 9-2 contains references for Host Manager tasks.

Table 9-2 Where to Find Host Manager Task Information

Task Location

How to Start Host Manager page 46

How to Add Standalone System Information page 47

How to Add Support for a Diskless Client page 49

How to Display Host Information page 54

How to Enable Remote Software Installation
Privileges

page 55

How to Delete Host Information page 56
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Window, Menu, and Command Descriptions

Host Manager Naming Service Window

When you start Host Manager or choose the Naming Service command, the
following window is displayed:

This window is used to select:

• The appropriate name service for your environment. See Chapter 2, “Name
Service Management,” for information on selecting a name service.

• The amount of host information to be displayed in the Host Manager main
window. This is done using the Show menu, which is described in
Chapter 1, “Administration Tool Overview.”

After you have selected a name service and a method for filtering the host
entries that are displayed, click on Apply. The host information is loaded and
the Host Manager main window is displayed.
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Host Manager Main Window

The Host Manager main window contains the Edit, Find, Naming Service and
Help menus, and displays host entries that have been added to the system, if
any.

Edit Menu Commands

The Host Manager Edit menu commands are described in Table 9-3.

Table 9-3 Host Manager Edit Menu Commands

Command Use This Command To ...

Add Host Add a host

View Host Display information for the host currently selected in the main
window

Delete Host Delete the host currently selected in the main window

Enable Remote
Install

Enable remote install privileges for the host currently selected
in the main window
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Find Menu Command

Use the Find command to find and highlight a host entry in the main window.

Naming Service Command

Use the Naming Service command to return to the Load window where you
can select an alternate name service.

Help Menu Commands

The Help menu command is used to access the Help Viewer online handbook,
which describes Host Manager functions and requirements. See “Using the
Help Viewer” on page 9 for more information.
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Host Manager Edit Menu

Add Host Window

Use the Add Host window to add network client information. Table 9-4 on the
next page describes the buttons, menus, and text boxes in the Add Host
window. You might not see all of the options, depending on which client type
(standalone, diskless, or dataless) you select.
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Table 9-4 Items on the Host Manager Add Host Window

Item Name Menu Type Description

Client Type Menu The client’s configuration type (standalone,
diskless, or dataless).

Host Name field The client’s host name.

IP Address field The client’s IP address.

Ethernet Address field The client’s Ethernet address.

Timezone Region Menu The major geographic time zone region.

Timezone Menu The local time zone.

File Server Menu The client’s file server. If you select Other, the
Specify File Server window is displayed, which
enables you to specify a file server other than
the ones listed in the pull-down menu. (See
Specify File Server window on the next page.)

OS Release Menu Used to list and select the client’s architecture
and operating system version.

Root/Swap Paths field Provides default path names for the client’s root
file system and swap area.

Swap Size field Provides a field to set the swap size (in
megabytes) for a diskless client.

Terminal Type field For SunOS 4.1.x systems only: Provides a field to
specify the terminal type for a diskless client.
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Specify File Server Window
This window is displayed if Other is selected from the File Server menu in the
Add window.

After you type an alternate file server name in the text box, click on Apply.
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View Host Window

The View Host window displays information on the host selected in the main
window.

The displayed information includes:

Field Name Description

Client Type Identifies the client’s configuration type (standalone, diskless,
dataless)

Host Name Displays the client’s host name

IP Address Displays the client’s IP address

Ethernet Address Displays the client’s Ethernet address

Timezone Region Displays the client’s regional time zone

Timezone Displays the client’s local time zone
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Remote Install Window

Use this window to enable remote installation privileges for an existing host.
Remote software installation privileges are also enabled or disabled when the
client system is added using Host Manager’s Add Host window for standalone
systems.

The Remote Install window information is described in Table 9-5.

Table 9-5 Items on the Host Manager Remote Install Window

Item Name
Menu
Type Description

Host Name Text box Displays the selected host name.

Ethernet Address Text box Displays the selected host‘s Ethernet address.

Media Server Menu Used to list and select the media server from which
the host can install remote software. Select Other to
specify an alternate media server in the Specify
Media Server window. (See Media Server window on
the next page).
If Host Manager does not understand how the CD is
mounted on the media server, a window is displayed
so that you can specify the path name of the CD. (See
the Specify Device window on the next page.)

OS Release Menu Used to list and select the client’s architecture and
operating system version.
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Specify Media Server Window

This window enables you to designate the media server from which remote
software will be installed.

Specify Device Window

Use this window to designate the path name for the mounted CD on the media
server.

This window is displayed whenever the remote install privileges are selected
and Host Manager cannot determine how the CD is mounted.
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Delete Host Window

To delete a host entry, select the host in the main window. Then select Delete
Host from the Edit menu. The following window is displayed asking you to
confirm the deletion:

Host Manager Find Command

Use the Find Host command to find and highlight a specific host entry in the
main window. You can use wildcards.

Type the host name you want to locate in the Host Name field. Click on the
Find button on the right.
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Files Modified by Host Manager
Table 9-6 describes the system files modified by Host Manager.

Table 9-6

System File Description

bootparams A file containing the file server that provides the client’s
root and swap areas

/etc/dfs/dfstab A file containing a series of share  commands that
make file resources available to the client system

ethers A file containing the client’s Ethernet address

hosts A file containing the client’s host name and associated
IP address

timezone A file containing the client’s time zone

/export/root/
hostname/etc/vfstab

A file listing which of the client’s file system entries to
mount at boot time

/tftpboot A directory containing diskless client booting
information
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This chapter provides reference information for Database Manager, a graphical
interface used to manage network-related system files.

Use this table to find information about specific Database Manager features.

Using Database Manager page 120

Database Manager Load Database Window page 121

Database Manager Main Window page 122

Database Manager Edit Menu page 124

Add Entry Window page 124

Modify Entry Window page 126

Delete Entry Window page 126

Find Command page 128

Files Modified by Database Manager page 129
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Using Database Manager

When to Use Database Manager

Database Manager can be used to perform the following tasks:

• Manage network-related system files using a graphical user interface that
provides search capabilities and syntax checking

• Manage system files on the local system or across the network using the
NIS+ or NIS name service (with the appropriate access privileges)

Requirements for Using Database Manager

The requirements for using Database Manager are:

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using Database Manager

Database Manager, like the other Administration Tools, cannot be used on an
ASCII terminal to modify or display system files. Use an editor and SunOS
commands to manage system files when using an ASCII terminal.

Where to Find Information on Specific Tasks

Table 10-1 contains references for Database Manager tasks.

Table 10-1 Where to Find Database Manager Task Information

Task Location

How to Start Database Manager page 57

How to Add a System File Entry page 59

How to Modify a System File Entry page 59

How to Delete a System File Entry page 59
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Window, Menu, and Command Descriptions
The following section describes Database Manager’s windows, menus, and
commands.

Database Manager Load Database Window

When you start Database Manager or choose the Load Database command
from the File menu, the following window is displayed:

This window is used to select the appropriate name service for your
environment. See Chapter 2, “Name Service Management,” for information on
selecting a name service.

After you have selected a name service, click on Load. The selected system file
is loaded and the Database Manager main window is displayed.
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Database Manager Main Window

The main window contains four menus: File, View, Edit and Help. The
contents of the aliases  file are displayed.

File Menu Commands

The Database Manager File menu commands are described in Table 10-2.

Table 10-2 Database Manager File Menu Commands

Command Use This Command To ...

Load Database File Return to the Load window to select another name service,
domain, host, or filter command

Write Text File Save a version of a system file in another directory
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View Menu Commands

The Database Manager View menu commands are described in Table 10-3.

Edit Menu Commands

The Database Manager Edit menu commands are described in Table 10-4.

Help Menu Commands

The Help menu command is used to access an online handbook, which
describes the Database Manager functions of and requirements. See “Using the
Help Viewer” on page 9 for more information.

Table 10-3 Database Manager View Menu Commands

Command Use This Command To ...

Show All Entries Display all file entries. This is the default.

Show Entries That
Match

Display entries that match the specified text string

List By Item Display system file by item category

Find Find and highlight the first occurrence of an entry that matches
the specified text string

Table 10-4 Database Manager Edit Menu Commands

Command Use This Command To ...

Add Entry Add an entry to a system file

Modify Entry Modify an entry in a system file

Delete Entry Delete an entry in a system file
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Database Manager Edit Menu

Add Entry Window

Use the Add Entry command on the Edit menu to add an entry to a system file.
For example, you can create a new alias in the aliases  file by supplying a
new alias name and a list of alias members in the Expansion field.

See Table 10-5 on page 125 for a list of required fields when adding entries to
the system files managed by Database Manager.
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Table 10-5 summarizes the network-related system files managed by Database
Manager and the fields that are required and optional when adding entries.

Table 10-5 System File Fields and Descriptions

System File Field Name
Required or
Optional

Field Modifiable by
Database Manager? Field Description

aliases Alias
Expansion

Required
Required

No
Yes

Mail alias name
List of alias members

locale Host Name
Locale
Comment

Required
Required
Optional

No
Yes
Yes

Host name of client system
Native language environment variable
Text describing locale

netgroup Net Group
Members

Required
Required

No
Yes

Network group name
List of hosts in network group

netmasks Network
Number
Subnet Mask
Comment

Required
Required
Optional

No
Yes
Yes

IP network number
Subnetwork mask number
Text describing netmasks

networks Net Name
Net Number
Aliases
Comment

Required
Required
Optional
Optional

No
Yes
Yes
Yes

Network name
Network number
Aliases for network name
Text describing networks

protocols Protocol Name
Protocol
Number
Aliases
Comment

Required
Required
Optional
Optional

Yes
No
Yes
Yes

Official protocol name
Protocol number
Aliases for protocol name
Text describing protocols

rpc RPC Name
RPC Number
Aliases
Comment

Required
Required
Optional
Optional

Yes
No
Yes
Yes

Name of RPC program
RPC program number
Aliases for program names
Text describing rpc

services Service Name
Port Number
Protocol Name
Aliases
Comment

Required
Required
Optional
Optional
Optional

Yes
No
No
Yes
Yes

Official Internet™ service name
Service port number
Protocol used to provide service
Aliases for service names
Text describing services
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Modify Entry Window

Use the Modify Entry command on the Edit menu to add or remove an entry
from a system file. For example, an alias in the aliases  file can be modified
by adding or removing user names from the members list in the Expansion text
box. You cannot modify the alias name.

Table 10-5 on page 125 summarizes the modifiable fields of system files that are
usually managed by Database Manager. If a field is not modifiable using
Database Manager, you can delete the entry and re-add it with the changed
information.

Delete Entry Window

To delete an entry from a file, select the entry from the Database Manager main
window. Then select Delete Entry from the Edit menu. The following window
is displayed asking you to confirm the deletion:
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Database Manager View Menu

The View menu contains commands to find and sort system file entries.

Show All Entries

This is the default value, which displays all entries in the selected file.

Show Entries that Match

Show Entries that Match is used to display all entries that match the specified
text string.
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List by Item Command

This option allows you to sort the file by a field within the file.

Find Command

The Find command enables you to search through the specified file for a
particular entry. This command is useful when you are working with a large
number of entries.
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Files Modified by Database Manager
The network-related system files modified by Database Manager are described
in Table 10-6. Some of these files should be managed by their primary tools.

Note – All of the system files and their primary tools are summarized in
Table 10-7 on the next page.

Table 10-6 Files Modified by Database Manager

System File Description

aliases Contains aliases in ASCII format for the local host. Or, if it is
an NIS+ or NIS file, contains aliases available for use across
the network.

auto.home  (NIS) or
auto_home  (NIS+)

Contains entries for client systems to mount their home
directories automatically; an indirect automounter map.

bootparams Contains a list of client systems that need to boot from the
network.

ethers Contains Ethernet addresses of network client systems.

hosts Contains a list of systems on the network and their
associated IP addresses.

locale Contains the default locales used by network clients.

netgroup Contains entries for netgroups, a group of systems granted
identical access to network resources for security and
organizational reasons.

netmasks Contains network mask values used to implement IP
subnetting.

networks Contains information about available networks.

protocols Contains information about Internet protocols used in your
network.

rpc Contains entries for available RPC services (by name) and
their associated program numbers and aliases.

services Contains information about network services and their
“well-known” port numbers.

timezone Contains entries for systems and their geographic region and
time zone used at installation.
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Table 10-7 System Files and Their Primary Management Tools

System File Administration Tool

aliases , locale , netgroup , netmasks ,
networks , protocols , rpc , and services

Database Manager

bootparams , ethers , hosts , and timezone Host Manager

/etc/lp  directory Printer Manager

/etc/saf  directory Serial Port Manager

passwd  and auto_home  (or auto.home ) User Account Manager
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This chapter provides reference information for the Serial Port Manager.

Use this table to find information about specific Serial Port Manager features.

Using Serial Port Manager page 132

Serial Port Manager Main Window page 134

Modify Service Window page 136

Template Menu page 138

Baud Rate Menu page 138

Port Monitor Tag Menu page 139

Timeout Menu page 139

Delete Service Window page 140
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Using Serial Port Manager

When to Use Serial Port Manager

Use Serial Port Manager to configure serial port software for use with
terminals or modems. You can use Serial Port Manager to configure one or
more ports on a local or remote system.

With Serial Port Manager, you can

• Add a service
• Modify a service
• Initialize a port without configuring the service
• Disable a service
• Delete a service

Requirements for Using Serial Port Manager

The requirements for using Serial Port Manager are:

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using Serial Port Manager

When you configure a serial port for use with a modem or terminal, you have
a choice between two tools:

• Service Access Facility—a collection of background processes and
administrative commands used from the command line to configure and
administer port services and monitors.

• Serial Port Manager—an Administration Tool application that provides a
graphical user interface and the functionality of the Service Access Facility’s
pmadm command, a port monitor administration tool.

For more information about the Service Access Facility and when to use the
Service Access Facility or Serial Port Manager, see Peripherals Administration.
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Where to Find Specific Task Information

This table contains references for Serial Port Manager tasks.

Table 11-1 Where to Find Serial Port Manager Task Information

Task Location

How to Start Serial Port Manager page 63

How to Add a Terminal page 64

How to Add a Modem page 66

Initializing a Port Without Configuring page 69

How to Disable a Port page 71

How to Delete a Port Service page 72
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Window, Menu, and Command Descriptions

Serial Port Manager Main Window

The Serial Port Manager main window lists the existing services that have been
configured on your system. It also contains menu buttons that help you modify
or delete a service.

The main window contains the Edit, Goto, and Help menus.

Edit Menu Commands

The Serial Port Manager Edit menu commands are described in Table 11-2.

Table 11-2 Serial Port Manager Edit Menu Commands

Command Use This Command To ...

Modify Service Modify a service

Delete Service Delete a service
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Goto Command

The Goto command enables you to manage serial port information on another
system. To configure the port services on another system, you need
administrative privileges for that system. See Chapter 2, “Name Service
Management,” for more information on Administration Tool security.

Help Menu Commands

Use the Help menu command to access an online handbook that describes the
functions of and requirements for the Serial Port Manager application. See
“Using the Help Viewer” on page 9 for more information.

Serial Port Manager Edit Menu
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Modify Service Window

When configuring port information, choose Modify Service from the Edit menu
to bring up the Modify Service window.

Basic

More

Expert
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The descriptions of each item in the Modify window are listed in Table 11-3.

Table 11-3 Items on the Serial Port Manager Modify Window

Detail Item Name Menu Type Description

Basic Port Menu Lists the port or ports you selected from Serial Port Manager’s
main window.

Service Field Specifies that the service for the specified port is turned on
(enabled).

Baud Rate Menu Specifies the line speed used to communicate with the terminal.
The line speed represents an entry in /etc/ttydefs .

Terminal Type Field Shows the terminal type abbreviation, for example, wyse50,
ansi, or vt100. Similar abbreviations are found in
/etc/termcap . This value is set in the $TERM variable.

More Option: Initialize Only Menu option Specifies that the port software is initialized but not configured.

Option: Bidirectional Menu option Specifies that the port line is used in both directions.

Option: Software Carrier Menu option Specifies that the software carrier detection feature is used. If
the option is not checked, the hardware carrier detection signal is
used.

Login Prompt Field Shows the prompt displayed after a connection is made.

Comment Field Shows a text description of the service, if any.

Service Tag Current
setting

Lists the service tag associated with this port—typically an
entry in the /dev/term  directory.

Port Monitor Tag Menu Specifies the name of the port monitor to be used for this port.
Note: The default monitor is typically correct.

Expert Create utmp  Entry Check box Specifies that a utmp  entry is created in the accounting files
upon login. Note: This item must be checked if a login service is
used. See the Service item.

Connect on Carrier Check box Specifies that a port’s associated service is invoked immediately
when a connect indication is received.

Service Field Shows the program that is run upon connection.

Streams Modules Field Shows the STREAMS modules that are pushed before the
service is started.

Timeout (secs) Menu Specifies the number of seconds before a port is closed if the
open process on the port succeeds and no input data is
received.
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Template Menu
The template menu provides a list of templates that help you quickly set up a
port service. Table 11-4 describes the template menu.

Choose the template that most closely matches the port configuration you
want. You can then change values in the Modify window to meet your needs.

Baud Rate Menu
The baud rate menu provides a list of common baud rates. These entries are
also listed in the /etc/ttydefs  file.

Table 11-4

Template Is Used To ...

Terminal — Hardwire Connect an ASCII terminal

Modem — Dial In Only Connect a modem with dial-in service, allowing
users to dial in to the modem but not dial out

Modem — Dial Out Only Connect a modem with dial-out service, allowing
users to dial out from the modem but not dial in

Modem — Bidirectional Connect a modem with bidirectional service,
providing users with both dial-in and dial-out
capabilities

Initialize Only — No Connection Initialize the port only; does not provide
connection service

38400

19200

9600

2400

1200

300

auto

Other
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To specify a baud rate not listed, choose Other. The Baud Rate window is
displayed.

To specify a valid baud rate, enter a value from the /etc/ttydefs  file and
click on Apply.

Port Monitor Tag Menu
The port monitor tag menu lists the default tag—zsmon—and Other. To specify
a tag other than zsmon, choose Other. The Port Monitor Tag window is
displayed.

Timeout Menu
The timeout menu provides a list of common timeout parameters. If no input
data is received within the timeout parameter, the port will be closed.

Never

30

60

120
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Delete Service Window

To delete a service on a configured port, select the port that has a service you
want to delete. Choose Delete Service from the Edit menu. The following
window is displayed asking you to confirm the deletion:
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Files Modified by Serial Port Manager
Table 11-5 describes the files that are modified by Serial Port Manager.

Table 11-5 Files Modified by Serial Port Manager

System File Description

/etc/saf/_sactab The Service Access Facility’s administrative file that contains
configuration data for the port monitors it controls

/etc/saf/ pmtag/
_pmtab

The port monitor’s administrative file that contains port
monitor-specific configuration data for the services it
provides

/var/saf/ pmtag/
log

The port monitor’s log file logging service states: successful
initialization, failure, enabled, or disabled
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This chapter provides reference information for the Software Manager.

Use this table to find information about specific Software Manager features.

Using Software Manager page 144

Software Manager Main Menu Window page 145

File Menu Commands page 146

View Menu page 149

Edit Menu page 151

Props Menu page 151

Source Media page 152

Package Administration Window page 154

Current Product Category Window page 161

Browser Display Window page 163

Remote Hosts Window page 165
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Using Software Manager

When to Use Software Manager

Use Software Manager to:

• Save configuration files
• Select software to install or remove from the local machine
• Display a graphical overview of storage space used by a file system

Requirements for Using Software Manager

The requirements for using Software Manager are:

• A bit-mapped display monitor
• Ability to use the OpenWindows environment
• Access privileges as described in Chapter 1, “Administration Tool

Overview”

Alternatives to Using Software Manager

Software Manager cannot be used on an ASCII terminal. If needed, all
software-related tasks can be performed using the package administration
commands. Table 12-1 provides more information about choosing to use
package administration commands or Software Manager.

Table 12-1 When to Use Software Manager

Use Software Manager If You:
Use Package Administration Commands
If You:

Have a bit-mapped display monitor Are using an ASCII terminal

Are running OpenWindows Want output for each command issued
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Window, Menu, and Command Descriptions

Software Manager Main Menu Window

The Software Manager main window lists the software applications available
for installation or removal. It has three areas: a main control panel, a level
display, and a software selection area.

Main Control Panel

The main control panel contains menu items that allow you to take specific
actions and bring up other windows and options. In addition, the main control
panel contains the Category field which displays the product. (See “Current
Product Category” on page 161 for more information about the product
category.)

Software Selection Area

Main Control Panel

Level Display
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Level Display

The level display uses icons to represent the software available for installation
or removal. The level display lists the software in a hierarchic view, allowing
easy movement among levels of the hierarchy.

The Software Selection Area

The software selection area displays the software in the current distribution. In
this window, you select the software you want to install or remove.

In the bottom area of the window, Software Manager displays the software
modules found in the active software distribution. The format of this display is
controlled by the Software Manager’s display properties. See “Browser Display
Window“on page 163 for more information.

You can limit the number of modules displayed by using the Current Product
Category window (see page 161).

The border of each module’s icon shows whether any version of that module is
currently installed on the local system. The three possible border types are
listed in Table 12-2.

To select a module for installation or removal, click on the module icon.
Selected items appear in reverse video (white on black).

Table 12-2 Icon Borders in the Software Selection Area

Icon Border Description

None No version of the module is installed on the local system.

Solid The version of the module being examined is already installed on
the local system.

Broken
or Dashed

The version of the module being examined is different from the
version of the module already installed.



Software Manager Reference 147

12

Pressing MENU (right) mouse button while the pointer is positioned over a
module displays the Software menu:

Table 12-3 describes the Software menu commands, some of which may not be
active (they will be grayed out), depending on the module’s type.

Table 12-3 Software Menu in the Software Selection Area

Command Use This Command To...

Package Properties Display a pop-up window containing additional statistics
describing the module.

Select Localizations Choose which localizations to install or remove.

Read About (If active) See more information about the module. (Drag
the mouse to the right of this command to display a menu
containing additional textual descriptions of the module.)

Run (If active) Run a demonstration of the module. (Drag the
mouse to the right of this command to display a menu
containing the names of executable demonstrations of the
module.)

Set Base Directory Specify the directory in which a software module should
reside. If the module is a cluster, all its components will be
installed relative to this root directory.

Expand (If active) View and select a cluster’s individual
components. Double-clicking on a cluster also expands it.
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Double-clicking over a software cluster expands the cluster into a scrolling list
of its software packages. Double-clicking while the cursor is positioned over a
software package displays the package’s property sheet. The following figure
shows an example property sheet.
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File Menu Commands

The Software Manager’s main window File menu commands are summarized
in Table 12-4.

View Menu

The View menu commands are summarized in the following table.

Table 12-4 File Menu Commands in Software Manager’s Main Window

Command Use This Command To...

Save Save the configuration file. The default path is ./.swmrc . If you
used the command line to specify a configuration file, pressing
Save in the File menu saves the configuration file you specified
on the command line (with the -c  option).

Save as Save the current configuration file as a new file with a new name.
Specify the directory path and the name of the configuration file.

Table 12-5 View Menu Commands in Software Manager’s Main Window

Command Use This Command To...

Prev Level Reverse the Expand command. Use this command after you have
expanded a software cluster in either the software selection or
level display areas. Returning to the previous level enables you to
view and select the modules contained in the cluster you most
recently expanded

Command
Window

Display the window in which Software Manager executes
programs. The most important are pkgadd  and pkgrm , the
package installation and removal commands.

Space Meter Display a window that shows a graphical overview of storage
space used by file systems. The Space Meter window shows how
many megabytes a file system uses, and how many megabytes
are free.
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Space Meter Window
The Space Meter window indicates how much disk space is required to install
the selected software or how much disk space would become available after
you remove selected software. The meter automatically displays the first time
you select a software module for which there is insufficient disk space.

Table 12-6 lists and describes the columns in the meter.

Table 12-6  Window fields in the Space Meter

Field Description

File System
(left
column)

Mount point name. Software Manager tracks several possible mount
points and calculates space totals for those that correspond to actual
mount points on your system. Names that are not mount points are
grayed out.

Percentage
Used
 (the meter)

Graphically represents the combined percentage of disk space used
and disk space required to install selected software.

Mb Used Total, in megabytes, of the amount of disk space currently in use plus
that required to install selected software.

Mb Free Amount of free space, in megabytes, that would remain in each file
system after installation of any selected software. A negative value
indicates the program estimates insufficient space is available for the
selected software.



Software Manager Reference 151

12

Edit Menu

The Edit menu enables you to add client support software and selecting or
deselecting groups of software packages.

Table 12-7 summarizes Edit menu commands.

Note – Deselect All behaves differently than Select All. Deselect All will
deselect all modules, visible or not, whereas Select All selects only modules
that match the current software category.

Props Menu

The Props menu invokes the Properties window, which you can use to save or
edit the configurable properties of Software Manager. The Properties window
contains the following categories:

• Source Media

• Package Administration

• Current Product Category

• Browser Display

• Remote Hosts

The following sections describe each of these categories.

Table 12-7 Edit Menu Commands

Command Use This Command To...

Native
Environment

Select software to install or remove from the local machine.

Add Client
Support

Add support (services) for diskless clients.

Select All Select all modules matching the current category.

Deselect All Deselect all modules currently selected.
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Source Media

The Source Media category lets you specify the physical format (type), and
name (device name or directory name) of the software distribution you want to
examine. Table 12-8 on the following page describes the menu items in the
Source Media window.
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.

Note – You must set Media Type to Directory and use the Directory Name field
if Volume Management controls the device you want to use. By default,
Volume Management automatically mounts the CD-ROM.

Table 12-8  Menu Items in Source Media

Item Description

Media Type Specifies the physical format of the software distribution you intend to examine.
The Software Manager supports two types of formats:
CD-ROM – Use this setting to examine a software distribution from a locally
attached CD-ROM device not yet mounted as a local file system.
Directory – Use this setting if your software distribution has already been locally
mounted. If your software is CD-based and you do not have a local CD-ROM
device, you will need to use this setting and mount the disk manually, using
NFS®.

Device Name Specifies the name of the device containing the software distribution. Use this
field if you indicated your software is CD-based. For a standard local CD-ROM
device, the default device, /dev/dsk/c0t6d0s0 , should suffice. The device
name you specify must not be mounted or must have been mounted from within
Software Manager. Consult the documentation included with your software
product for further information.

Directory
Name

Specifies the location of a mounted software distribution. Use this field if you
indicated your software is already mounted. Enter the path name of the
distribution. Press the Return key after entering your text to begin the load
operation.
Note: This path can be relative; however, Software Manager does not recognize
the home directory expansion character, tilde (~).
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Package Administration Window

The Package Administration window contains menu items that allow you to
set Package Administration options. Status messages may be displayed at the
bottom of the window. The fields and options are discussed in the following
pages.
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Mail Recipients Field

The Mail Recipients list contains the mail addresses of people who should be
informed about the installation or removal of a package. Enter the name of a
recipient in the Recipient Name field and use the buttons listed in Table 12-9 to
update the list.

Recipient Name Field

Use the Recipient Name field to specify the mail address of a recipient.

Existing Files Options

Use the Existing Files options to control attempts to overwrite existing files.
The options are described in Table 12-10.

Table 12-9  Mail Recipients Buttons in the Package Administration window

Button Description

Add Adds an address to the recipient list.

Delete Deletes an address from the recipient list. To delete an address from
the list, select the address and click on the Delete button.

Change Modifies an address already in the recipient list. To change an
address, select the address and enter the new address in the
Recipient Name field. Click on Change.

Table 12-10 Existing Files options in the Package Administration window

Option Use This Option To...

Ask Receive a confirmation prompt before existing files are
overwritten.

Overwrite Replace existing files with the version contained in the package.

Skip Install new files but skip installation of files that already exist.

Abort Abort the operation without making any changes to the system if
it detects conflicts with existing files.
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Existing Packages Options

Use the Existing Packages options to control attempts to install packages more
than once. The options are described in Table 12-11.

Existing Partial Installation Options

Use the Existing Partial Installation options to control attempts to reinstall a
partially installed package. The options are described in Table 12-12.

Table 12-11  Existing Packages options in the Package Administration window

Option Use This Option To...

Ask Receive a confirmation prompt before any attempt to install a package
that has already been installed. (This check is based on package
name.)

Overwrite Install packages in place of any previous installations. Note that you
are only allowed to reinstall the package “on top” of the old one. You
are not allowed to install the package in a different location.

Install
Unique

Install packages as uniquely named instances, if they are installed
already. Note that this option may overwrite existing files. This option
is useful if you are installing packages that are architecture- or locale-
specific pieces of a product, or if you want to install a new version of
a previously installed package in a different location.

Abort Abort the operation without making any changes to the system if you
attempt to install a package more than once.

Table 12-12 Existing Partial Installation Options in the Package Administration Window:

Option Use This Option To...

Ask Receive a confirmation prompt before any attempt to reinstall a
partially installed package.

Ignore Ignore previous attempts to install the package, overwriting any
previous partial installations.

Abort Abort the operation if Software Manager detects a previous partial
installation. In this case, Software Manager will not make any
changes to the system.
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Install Setuid/Setgid Files Options

Use the Install Setuid/Setgid Files options to control attempts to install files
with set-ID bits activated. The options are described in Table 12-13.

Run Setuid/Setgid Scripts Options

Some packages contain scripts to be executed after the package is installed or
removed. These “action” scripts potentially impact system security if their
setuid  or setgid  bits are enabled. Use the Run Setuid/Setgid Scripts options
to control attempts to run scripts with set-ID bits activated. The options are
described in Table 12-14.

Table 12-13 Install Setuid/Setgid Files Options in the Package Administration Window

Option Use This Option To...

Ask Receive a confirmation prompt before attempts to install a file with
setuid  or setgid  bits activated.

Yes Install files regardless of the states of their setuid  and setgid
bits.

No Install setuid  and setgid  files with their setuid and setgid bits
turned off.

Abort Abort the operation without making any changes to the system if
Software Manager detects an attempt to install setuid  or setgid
files.

Table 12-14 Run Setuid/Setgid Scripts options in the Package Administration window

Option Use This Option To...

Ask Receive a confirmation prompt before executing a setuid  or setgid
action script.

Yes Install packages regardless of the security impact of their action scripts.

Abort Halt the operation without making any changes to the system if the
installation program encounters a package containing setuid  or
setgid  action scripts.
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Installation Dependencies Not Met Options

Use the Installation Dependencies Not Met options to control attempts to
install packages without satisfying all prerequisites. The options are described
in Table 12-15.

Removal Dependencies Not Met Options

Use Removal Dependencies Not Met options to control attempts to remove
packages required by other packages. The options are described in Table 12-16.

Table 12-15 Installation Dependencies Not Met Options Package Administration window

Option Use This Option To...

Ask Receive a confirmation prompt before attempts to install a package
without all prerequisite packages installed.

Ignore Install a package even if all packages on which it depends have not
been installed.

Abort Abort the operation without making any changes to the system if
prerequisite packages are not completely installed.

Table 12-16 Removal Dependencies Not Met Options in Package Administration
Window

Option Use This Option To...

Ask Receive a confirmation prompt before removing a package required by
other packages.

Ignore Remove a package even if it is required by other packages.

Abort Abort the operation without making any changes to the system if you
attempt to remove a package required by other packages.
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Incorrect Run Level Options

Use Incorrect Run Level options to control attempts to install packages when
the system run level does not match the run level specified by the package. The
options are described in Table 12-17.

Insufficient Space Options

Use the Insufficient Space options to control attempts to install packages for
which there is insufficient space. The options are described in Table 12-18.

Show Copyrights Field

Usually each software package comes with a long copyright notice that is
displayed when the package is installed. This message can take a significant
amount of time and resources to display. The Show Copyrights field controls
the display of verbose messages like copyrights during package installation.

To see these copyright notices, select Yes, otherwise select No.

Table 12-17 Incorrect Run Level Options in the Package Administration Window

Option Use This Option To...

Ask Receive a confirmation prompt before installing a package with the
system at a run level not specified in the package.

Ignore Install packages regardless of the current or specified run levels
(installation of the package is still subject to other consistency checks).

Abort Abort without making any changes to the system if you attempt to
install a package when the system's run level does not match one of
those specified by the package.

Table 12-18 Insufficient Space Options in the Package Administration window

Option Use This Option To...

Ask Receive a prompt before installing a package for which there is not
enough disk space.

Ignore Install packages regardless of the amount of disk space available.

Abort Abort without making any changes to the system if you attempt to
install a package for which there is not enough disk space.
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Install/Remove Interactively Field

Package installation and removal can either be interactive or noninteractive. If
run interactively, the Software Manager will prompt you for appropriate action
if any of several error or abnormal conditions arise. If you disable interactivity,
these conditions result in the failure of the package operation in progress
(other operations may proceed).

The Install/Remove Interactively field controls the ability to interact with
package installation and removal commands.

If you would like to execute package installation and removal commands
interactively, select Yes, otherwise select No.

Action Buttons

The buttons described in Table 12-19 inform the Software Manager of changes
made in the Package Administration Properties window.

Table 12-19 Action Buttons in the Package Administration Window

Button Description

Apply Save current Package Administration settings for use during the current
session of software installation and removal.
Saving current settings does not save the settings to a file; you must use
the File menu items Save or Save As.

Reset Reset Package Administration settings to match current program values.
These values are those in force when you last pressed Apply or those
taken from the program's configuration file (if you have not yet applied
any changes).
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Current Product Category Window

The Current Product Category window enables you to restrict to specific
categories the software displayed in the Software Display area.

Categories List

This list contains the software categories to which the modules in the currently
active software distribution belong.

Software vendors can attach category names to the modules in their
distributions. You may limit the number of modules displayed in the Software
Selection area by selecting a category (the selected category will appear
highlighted), then clicking on Apply. Only modules in the current category will
be displayed. To display all modules, select All Software from the list, then
click on Apply.
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Action Buttons

Table 12-20 describes the Current Product Category Action buttons.

Table 12-20 Action Buttons in the Current Product Category Window

Button Description

Apply Saves the selected (highlighted) name as the currently active category.

Reset Resets the Categories list to match the current category. This operation
does not change the current category.
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Browser Display Window

Display Format

The Display Format option field is used to specify software modules are
represented in the Software Selection area. The available formats are listed in
Table 12-21.

Table 12-21 Display Format Options in the Browser Display Window

Format Use This Mode To...

Automatic Invoke the default display mode of the software module. If any
module in the current display has an icon, all modules primarily
display as icons. If a particular module does not have an icon, a
generic icon is used. If no modules have icons, all modules are
primarily displayed as text, with a small generic icon representing
each module's type.

Iconic Force all modules to be displayed as icons. If no icon is explicitly
associated with a module, a generic icon is used.

Textual Force representation of modules as names. Each name is
accompanied by a small generic icon that denotes the module's type
(individual package or cluster) and an indication of the total amount
of disk space required to install the module.
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Name Length Options

This field specifies the format of module names in the Software Selection area.
The formats are described in Table 12-22.

Number of Columns Field

This field specifies the number of columns used in text mode (1, 2, or 3).

Action Buttons

Table 12-23 describes the Browser Display window Action buttons.

Table 12-22 Name Length Options in the Browser Display Window

Format Use This Format To...

Long Display the full name of each module.

Short Display the abbreviated name of each module. This format is useful if
you are using multiple columns.

Table 12-23 Action Buttons in the Browser Display Window

Button Description

Apply Temporarily saves the current display settings and updates the display.
Note that this does not save the settings to a file; this must be done
using the Props menu items Save or Save As.

Reset Resets settings to match the display.
These values are those in force when you last pressed Apply, or those
taken from the Software Manager's configuration file (if you have not
yet applied any changes).
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Remote Hosts Window

The descriptions on the following pages explain the use of the fields and
buttons shown in the Remote Hosts window.
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Edit Menu

The Edit Menu, shown below, enables you to add, modify, or remove entries in
the Target Hosts list.

Toggle Selection

Pressing this button toggles between SELECTED and UNSELECTED in the
Target Hosts list.

Clear

Pressing this button clears any entry in the Root Password field.

Note – For security reasons, clearing this field will not display the password.

Target Hosts List

The Target Hosts list contains the names of hosts on which software can be
installed or removed. The Target Hosts list has three fields:

• Machine Name

• Machine Architecture

• SELECTED/UNSELECTED

Use this list to specify hosts on which software is to be installed or removed.
This is a three-step process that entails:

1. Editing the list and add any desired hosts.

2. Selecting hosts from the list.

3. Pressing the Apply button.
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Use the Mode setting to switch between host list editing and host selection.
Each host name is accompanied by a small symbol indicating the host's status.
See Table 12-24 for a description of the Target Hosts symbols and their
meaning.

Host Name Field

Use the Host Name field to specify the name of a new host. This field is used
when you add and modify host entries.

Root Password Field

Use the Root Password field to specify the root password for the host identified
in the Host Name field.

To execute programs on remote systems, Software Manager requires either a
.rhosts  entry on the remote system, or that you know the remote system's
root password. If a root password is required, you will be notified by pop-up
notices and the password-required symbol (a circle with a diagonal line) in the
host list. In either case, the CONSOLE entry in /etc/default/login  must be
commented out.

Root passwords are not stored in the Software Manager configuration file.
They are flushed each time you quit the Software Manager, to protect the
security of the remote systems.

Table 12-24 Target Hosts Symbols and Their Meaning

Target Hosts glyph Meaning

The host is up. Software Manager has the necessary
permissions to install or remove software on this host.

The host is down.

The host is a known host on the network. Software Manager
does not have the necessary permissions to install or remove
software on this host.

The host is not known to the network or the host is not a
Solaris 2.x system.



168 Administration Application Reference Manual—August 1994

12

Action Buttons

After entering information on the remote hosts or selecting remote hosts, use
the Action buttons at the bottom of the Remote Hosts window to update the
Software Manager. These buttons are described in Table 12-25.

Table 12-25 Action Buttons in the Remote Hosts Window

Button Description

Apply Commit the host list and host selections to Software Manager.
Subsequent installations and removals during this session will operate
on the hosts selected in the order they appear in the list. Note that this
does not save the list to a file; this must be done using the File menu
items Save or Save As.

Reset Resets the host list and host selection values to the values in force when
you last clicked on Apply or the values from Software Manager's
configuration file (if you have not yet applied any changes). Note that
the file-based configuration does not save selection status or root
passwords.
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12

Install/Remove

The Install and Remove buttons on the Main Menu represent two modes of
behavior for the Software Manager—installing or removing software.
Table 12-26 describes the two modes.

Table 12-26 Mode field

Mode Select This Mode To...

Install Install software. Use the Software Selection area at the bottom of the
window to select modules to be installed.

Remove Remove software. After you press this button, the Software Selection
area at the bottom of the window shows the software packages installed
on the selected host. Use this area to select the packages you want to
remove.

Install and Remove Mode Buttons
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Glossary

admind
A distributed system administration daemon that carries out security tasks
when administrative tasks are performed across the network.

Administration Tool
A graphical user interface used to perform administrative tasks such as
managing users, groups, hosts, printers, and serial devices.

Administration Tool launcher
The main window of the interface used to start the other application tools.

aliases file

A file containing mail aliases, which are names that represent distribution lists
of users.

auto_home (or auto.home) file
An indirect automounter map containing entries that enable client systems to
mount their home directories automatically. It is primarily accessed using User
Account Manager.

bootparams file
A file containing entries used to enable client systems to boot from the
network.
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baud rate
The switching speed of a line, which is the number of changes in the electrical
state of the line per second. At low speeds, baud rate is equivalent to bits
transmitted per second. At higher speeds, the bits transmitted per second is
greater than the baud rate because one baud can be made to represent more
than one bit.

Berkeley Software Distribution (BSD)
One of two major “flavors” of the UNIX operating system, the other being
System V. SunOS operating system releases before SunOS 5.0 are the BSD
flavor.

content type
Specified when adding support for a local printer to identify the particular
formats of files that can be printed. Supported content types are: PS
(PostScript), ASCII, simple, or any.

default
An assumed value, or an action taken automatically unless you specify
otherwise.

device
A hardware component, such as a printer or disk drive, acting as a unit to
perform a specific function.

diskless client
A system with a monitor and keyboard, CPU and memory, and Ethernet
hardware. A diskless client gets it file resources and swap space from a server
on a network.

Database Manager
One of Administration Tool’s suite of applications used to manage
network-related system files such as aliases  and netmasks .

dataless client
A system with a monitor and keyboard, CPU and memory, Ethernet hardware,
and small local disk for the swap area and the root (/ ) file system. A dataless
client gets its other file resources from a server on the network.

Ethernet address
A system’s hardware address. You can display the Ethernet address by using
the banner  command from the PROM level.
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ethers file
A file containing Ethernet addresses of network client systems.

file server
A reachable system that shares file resources and disk storage space for
network clients.

file system
A hierarchy of files and directories in the SunOS operating system.

group
A collection of users who share files and other system resources. Each user
belongs to a primary group (listed in the user’s passwd  entry), and optionally,
one or more secondary groups.

group ID (GID)
A group identification number used by the system to identify a user’s primary
group. GID numbers for users usually range from 100 to 60000.

group file
A file containing entries for UNIX groups. The group  file is accessed from
Database Manager.

hardwired
Refers to a device such as a terminal that is physically connected to the local
system.

hosts file
A file containing host names and their associated IP addresses.

host name
A unique name that identifies a system.

Host Manager
One of Administration Tool’s suite of applications used to manage network
client services.

initialization files
Special files run automatically when you log in. When an account is created
and you specified a skeleton path, User Account Manager copies generic
versions of the initialization files into the user’s home directory. You can then
edit the copies as needed to customize each user’s environment.

IP address
A system’s unique network address.
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launcher
See Administration Tool launcher.

local printer
A printer physically connected to the local system.

locale file
A file containing the default locales used by network clients.

media server
A reachable system that shares a CD-ROM device for remote installation of
software.

modem

A data communication device that translates, or modulates, digital information
into an analog signal that can be transmitted via phone lines.

name service
Method by which system information is maintained in the network. There are
three types: NIS, NIS+, and None.

• NIS – Name service shipped with the SunOS 4.1.x operating system.
Designated machines, called NIS servers, contain maps that store
information about the network, its workstations, and its users.

• NIS+ – Name service shipped with the Solaris 2.x product. Making use of
true databases (instead of two-column maps that simply associate one
variable with another), NIS+ stores even more information than does NIS.

• None – Method for administrators of networks that do not use a network
name service; administrators usually select one machine on the network on
which to maintain a master copy of the /etc  configuration files.

name service domain
A group of systems and the information served to those systems.

Modem ModemComputer ComputerPhone

Digital signal

Analog signal

Lines 21
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netgroup file
A file containing entries for netgroups, a group of systems granted identical
access to network resources for security and organizational reasons.

netmasks file
A file containing network mask values used to implement IP subnetting.

network client
A system that uses remote resources from a server.

networks file
A file containing information about available networks.

nsswitch.conf
A file that contains an entry for each system file and a corresponding name
service source to search for the system file information. The name service
sources are designated as keywords— nis , nisplus , or files . If more than
one name service source is listed, they are searched in the order given.

OpenWindows
A windowing system based on the OPEN LOOK graphical user interface.

parallel port
A port that transfers one or more bytes simultaneously over multiple lines. See
also serial port.

passwd file
A file that contains user account information such as user name, user ID, group
ID, and home directory. It accessed using User Account Manager.

password status
A menu on the User Account Manager’s Add User window that enables you to
control user password characteristics. The choices are:
• Normal password – Sets a password for the user.
• Cleared until first login – Prompts user for a password on first login.
• Account is locked – Disables account with an invalid password, Account

can be unlocked by assigning a new password. This type of account allows
a user to own files but not log in.

• No password—setuid only – Disables the ability to directly log in to the
account. This allows programs such as lp  or uucp  to run under an account,
without allowing a user to login.
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permissions
A set of attributes assigned to each file and directory that determines which
users have access to read, write, and execute its contents.

port

A channel through which a device communicates with the operating system.

port monitor

A program that continuously “watches out” for requests to log in, or requests
to access printers or files.

When a port monitor detects a request, it sets whatever parameters are
required to establish communication between the operating system and the
device requesting service. Then the port monitor transfers control to other
processes that provide the services needed.

primary group
A user belongs to at least one primary (or default) group, which determines the
group ownership on a file the user creates, or is allowed to access, if already
created. Membership in this group is defined by the group identifier listed in
the user’s entry in the passwd  file.

print client
A system that uses a print server for printing files.

print server
A system with a printer physically connected to it and the appropriate
software configured to print both local and remote print requests.

Printer Manager
One of Administration Tool’s suite of applications used to manage local and
remote printer setup.

printer name
A unique name, with a maximum of 14 characters, for a printer.

printer type
The terminfo  database entry that contains the control sequences that
initialize the printer.
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PROM
A programmable read-only memory chip with a program called the monitor
that runs a quick self-test procedure and checks such things as the hardware
and memory on the system. If no errors are found, the system begins the
automatic boot process.

PROM prompt
The prompt displayed when the system is halted; either > or ok .

protocols file
A file containing information about Internet protocols used in your network.

remote printer
A printer connected to a remote system such as a print server.

rpc file
A file containing entries for available Remote Procedure Call (RPC) services
(by name) and their associated program numbers and aliases.

secondary group
Membership in this group is defined by the group identifier listed in the group
file with a list of users as members.

services file
A file containing information about network services and their “well-known”
port numbers.

serial port

A port which transmits a byte of information bit-by-bit over a single line using
a standard communications protocol such as RS-423. See also parallel port.

Serial Port Manager
One of Administration Tool’s suite of applications used to manage serial
devices.

shadow file
A file containing encrypted user passwords and password aging information.
It is accessed using User Account Manager.

shell
A command-line interpreter program that accepts and executes commands that
you type. There are several varieties of shell programs, and three are included
in the Solaris 2.x product: Bourne, Korn, and C.
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skeleton path
A prototype directory containing start-up files. See also initialization files.

standalone system

A system with a monitor and keyboard, CPU and memory, approximately 200
megabytes of disk space, and usually a backup device. It may or may not be
connected to a network.

superuser
A user who has access to all parts of the system. This is usually the system
administrator. Also known as root.

sysadmin group
The UNIX group whose members, along with a group ID of 14, can use
Administration Tool’s applications locally or remotely.

system default (printer)
The printer your print requests will be sent to if you do not specify a printer.

system files
Files that contain important system administration information such as user
accounts, passwords, and groups. These files are contained on the local system
in the /etc  directory, or in the NIS or NIS+ database on a name server.

System V
One of two major “flavors” of the UNIX operating system, the other being
BSD. The SunOS 5.0 operating system and subsequent releases are of the
System V flavor.

terminal

An input/output device that usually has a keyboard for input and a video
screen or printer for output. Terminal, however, is often used as a shorthand
for alphanumeric terminal, which is a serial port device capable of displaying
only letters, numbers, and other characters such as those produced by a
typewriter.

timezone file
A file containing entries for systems and their geographic region and time
zone.

user account
A record of essential user information stored on the system. You must have a
user account to access a system.
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user ID (UID)
A number used by the operating system to identify a user. UID numbers for
users usually range from 100 to 60000.

user name
The name a user uses to log in to a system.

workspace
The background screen area on which windows and icons are displayed.

User Account Manager
One of Administration Tool’s suite of applications used to manage user
account information.

utmp entry
A entry made in the /var/adm/utmp  file when a user logs in and out of the
system.

ypbind
A NIS daemon process that runs on all client systems and allows the client to
communicate with an NIS server.

zsmon
Sun’s naming convention for the port monitor that monitors a system’s two
serial ports. It is derived from the Zilog serial communications driver.
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Index

A
adding

dataless client support, 52
diskless client support, 49
modem, 66
system file entry, 59
terminal, 64
user account, 26

admind  daemon, 15
Administration Tool

additional security information, 15
applications, 3
benefits, 2
description, 1
launcher, 4
NIS+ environment, 12 to 14
no name service, 14
requirements for using, 3
security levels, 16
security policy, 19
setting up initial security, 20

aliases  file, 129
applications

buttons, 8
main windows, 7

B
Base directory, 147
bidirectional modem template, 68
bootparams  file, 129
Browser Display window, 163

C
cluster

expanding or opening a, 147
configuring printer services, 34
copyrights

to display during installation, 159
credentials, 16
Current Product Category window, 161

D
Database Manager

Add window, 124
advanced uses, 60
Delete window, 126
files modified by, 129
Find command, 128
Load window, 121
Main window, 122
Modify window, 126
starting, 57
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system file fields, 125
tasks, 59

dataless client
adding support, 52

deleting
files, 28
port service, 72
printer entry, 42
system file entry, 59
user account, 31

dependency checking, 158
dial-in only modem template, 68
dial-out only modem template, 68
Directory, setting base, 147
disabling a port, 71
diskless client

adding support, 49

E
Edit menu, 151
/etc/dfs/dfstab  file, 118
/etc/lp/filter.table  file, 104
/etc/lp/interfaces/ printer_name

file, 104
/etc/lp/printers  directory, 104
/etc/nsswitch.conf  file, 17
/etc/saf/ pmtag/_pmtab  file, 141
/etc/saf/_sactab  file, 141
/etc/skel  directory, 26
ethers  file, 129
existing files options, 155
existing packages options, 156
existing partial installation options, 156
/export/root/ hostname/etc/vfstab

file, 118

F
File menu, 149
files  name service, 17
filtering entries, 6

G
global security policy, 19

H
host information

deleting, 56
viewing, 54

Host Manager
add fields, 112
Add window, 111
Delete window, 117
files modified by, 118
Find command, 117
main window, 109
Naming Service window, 108
Remote Install window, 115
starting, 46
tasks, 47 to 54, 55 to 56
View window, 114

hosts  file, 129

I
icons, 10
incorrect run level options, 159
initialization files

setting up, 28
Initialize Only - No Connection

template, 70
install mode, 169
installation dependencies not met

options, 158
installing software

automatic mailing of changes, 155
interactively, 160
noninteractively, 160
overwriting existing files, 155
when there are existing packages, 156

insufficient space options, 159

L
level display, 146
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local printer
adding, 39
deleting, 42

local security policy, 19
locale  file, 129
localizations, 147

M
media

specifying the location of
installation, 152

media server, 55
modem

adding, 66
templates, 68

modifying
user account, 29

mv command, 28

N
name services

available, 11
netgroup  file, 129
netmasks  file, 129
networks  file, 129
NIS naming service, 17
NIS+ environment

using Administration Tool, 12
NIS+ name service, 17

P
Package Administration window, 154
Package Information window, 147, 148
package properties, 147
pmadm command, 132
port service

deleting, 72
disabling, 71

print client
defined, 34
setting up, 40

print server
defined, 34
setting up, 39

printer entry
adding a local, 39
adding access to remote, 40
deleting, 42
modifying, 41

printer information
print clients, 37
print servers, 36

Printer Manager
Add Access to Remote Printer

window, 96
Add Local Printer window, 97
Delete window, 101
Find command, 103
Main window, 94
Modify window, 100
starting, 38
tasks, 39 to 42

printer services
configuring, 34

Props menu, 151
protocols  file, 129

R
Remote Hosts window, 165
remote printers

adding access, 40
remote software installation privileges

enabling, 55
removal dependencies not met

options, 158
remove mode, 169
removing software

automatic mailing of changes, 155
renaming files, 28
rm command, 28
root access

security, 15
rpc  file, 129
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S
searching for

host information, 117
printer information, 103
system file information, 128
user account information, 32, 89

security levels for Administration Tool, 16
security policy

creating, 19 to 20
selecting a name service, 12
Serial Port Manager

Delete window, 140
description of, 62
files modified by, 141
main window, 134
modify window, 134 to 137
tasks, 64 to 72

Service Access Facility, 132
services  file, 129
Setting base directory, 147
setuid/setgid files options, 157
setuid/setgid scripts, 157
shadow  file, 90
Software Categories window, 161
Software Manager

main window, 145
menu commands, 147

software selection area, 146
Source Media window, 152
space meter, 150

example of, 150
standalone system information

adding, 47
sysadmin  group creation

NIS+ environment, 13
no name service, 14

system file entry
adding, 59
deleting, 59
modifying, 59

system files, 5

T
target hosts list

identifying host state, 167
terminal

adding, 64
template for, 65

Terminal-Hardwired template, 65
text boxes, 8
/tftpboot  directory, 118
timezone  file, 129

U
user account

adding, 26
deleting, 31
modifying, 29
searching for information, 32

User Account Manager
Add window, 81
Copy window, 88
files modified by, 90
Find command, 89
main window, 79
Modify window, 85
Naming Service window, 78
remove window, 89
starting, 23, 25
tasks, 26 to 28, 29 to 32

user ID, 82
user name, 82

V
/var/saf/ pmtag/_pmtab/log  file, 141
View menu, 149
viewing

host information, 54


